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Welcome to Umler 
Railinc Umler®/Equipment Management Information System (Umler) provides a variety of 
enhanced equipment management functions which can be completed through an Internet 
connection. This chapter presents an overview of Railinc’s Umler, its system requirements, 
descriptions and references to supporting documentation, contacts, as well as a description of 
standard Railinc web interface elements and the Umler-specific interface elements. 

Overview 
Umler is the industry’s central repository for registered rail and intermodal equipment in North 
America. This system rests at the heart of nearly all railway activities. It is critical for effective 
industry interline operations. It provides the physical characteristics of equipment and the 
inspection data needed for the safe routing, loading capabilities, and rating information for car 
hire accounting. Virtually all of the electronic exchange of rail equipment data relies in one form 
or another on Umler. It serves as the industry’s database for equipment management and 
inspection information. 

In order to facilitate the industry’s ever-changing business rules and government regulations, 
industry leaders commissioned the development of Railinc Umler. 

Railinc Umler allows users to access and manage rail equipment information through an Internet 
application. The Umler interface promotes greater efficiency by providing web-based access to 
the Umler database, allowing users to query and to make real-time updates to their data. This 
system has been designed to meet the data integrity needs of our customers by providing this 
greater flexibility in a fully-secure environment. 

What is New in This Version 

Functions 
This document has been updated to include Umler 4.8 functions. Major functions include: 

Create Blue 
Card PDF 

Blue card elements have been identified for locomotives ( ) and a link has 
been added to the locomotive detail pages to generate a Blue Card PDF. 



Umler® Welcome to Umler 
Web Interface  

Revised December 2013 2 Umler Version 4.8 

User Guide Structure 
This document has been reorganized to reflect the application menu order of Umler. It describes 
use and interpretation of new interface elements in Umler. 

Dictionary-like retrieval text appears in the headers. A full index is included. 

Screen captures generally show only the content area of the web pages (headers and footers have 
been removed). 

Railinc Single Sign On (SSO) information has been removed, and references to the Railinc Single 
Sign On User Guide added where needed. SSO information for Umler administrators has been 
moved to the Umler System Administrator User Guide. 

Whenever possible the term “select” is used to indicate making a choice using either the mouse or 
keyboard. Left-clicking generally activates a control or selects an item. Where a double-click is 
required, it is specified. 

Underlined blue links are functional links to go to another section of the user guide. 

General User Interface and System Requirements 
General user interface information (typical keyboard selection equivalents and shortcuts), as well 
as system requirements are available in the Railinc UI Dictionary. Application-specific interface 
information is described in the next section. 

Requesting Changes to Umler 
To request changes to Umler: 

1. Double-click the embedded document. 

Umler_Change_Requ
est.doc  

2. Complete the document and Save (leave open). 

3. Select the link at the top of the form. This opens an e-mail to CSC with the subject line set to 
Umler Change Request. 

4. Attach the saved document.  

5. Send the e-mail.  

https://www.railinc.com/rportal/alf_docs/UI/Railinc_UI_Dictionary.pdf
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Supporting Documentation 

Umler™ Data Specifications Manual 
The Umler Data Specification Manual provides the data requirements and input formats to 
register equipment into the Umler system and is needed when registering equipment. It also 
contains tables of business rules and field definitions. The Data Specification Manual is available 
on the Railinc website and within the application by selecting the Help link on the upper right of 
any page. 

The current version of the Umler Data Specifications Manual can be downloaded from Railinc at 
the following link: https://www.railinc.com/rportal/web/guest/umlerreferences. 

AAR Field Manual 
Published by the Association of American Railroads (AAR), this manual contains all rules 
dealing with the care and repair, responsibility for, disposition of, settlement of freight 
equipment.  It includes the procedures for the operating and billing of maintenance pools. 

Information for ordering this manual can be found on the AAR’s publication website 
www.aarpublications.com/. 

Railinc Contacts 
The Railinc Customer Support Center  (CSC) is a free service to Umler users and is operational 
twenty-four hours a day, every day of the year. Call (877) 724-5462 or e-mail csc@railinc.com to 
report problems accessing Umler. Password, user ID and other issues related to access will be 
solved as soon as possible. 

 

https://www.railinc.com/rportal/web/guest/umlerreferences
http://www.aarpublications.com/
mailto:csc@railinc.com
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Web Interface 
The Umler interface provides the same navigational tools found in most Windows applications 
and Internet sites.  This section provides basic explanations of the elements and components that 
assist in moving through the various pages of the application to complete tasks. Mouse and 
keyboard equivalents are discussed for each element. 

Railinc Web Page Layout 
Each page in a Railinc web application has the same structure. 

Exhibit 1. Railinc Web Application Page Layout 

 

1 Logo—Railinc logo. Logo is link to the Railinc corporate website. 

2 Application Title—Name of the application. This is also a link to the Home page of the 
application. 

3 User ID—Logged in user. 

4 Company—Company user is representing. For individuals representing several roads. 
Selecting this link while logged on (hand pointer shown below) opens the Select Your 
Company page (Exhibit 7), to reselect the company on whose behalf the user will be 
working—without logging out. 

 

5 Launch Pad—Link where the user can click to go directly to the SSO Launch pad, or hover 
over to display a dual drop-down menu to switch to other authorized Railinc applications (left 
side) or go to the SSO User Services functions (right side), e.g., change passwords, request 
other applications, etc. (Exhibit 2). 
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Exhibit 2. Launch Pad Link Drop-Down Menu 

 

6 Contact Us—Opens a page of contact information (local road, Railinc support). 

7 Sign Out—Logs out of current application and returns to the Railinc SSO login page. 

8 Application Menu—The top of the Railinc page displays the application menu options. The 
options on this menu allow you to perform the various functions of the application. Some 
specific options include: 

• Help—Opens a new window with page-specific help. 

• References—Opens a page with links to various reference documents (e.g., user guide, 
specification manual, etc.). 

9 Display Unit Lookup—Selecting the icon ( ) allows the user to look up and display a 
unit in a new window without interrupting work on the current page. The Display Unit 
window can be closed when viewing is completed. 

10 Page Title—The title of the specific application task page. 

11 Message Area—Area under the page title which displays messages as needed (shown 
outlined with blue dashes). Error messages are red with a light red background. 
Informational/warning messages are black on a light yellow background. Success messages 
are green on a light green background. 

12 Page content area—The area of the page where tasks are executed (shown outlined with red 
dashes). These vary and may include a number of different elements, which are described in 
the next sections.  

13 Legal Links—This area at the bottom left of each page contains links to applicable legal 
notices, privacy rights, terms of service, and the Contact Us. 

14 Copyright—This area at the bottom right of each page shows copyright information. 
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Umler-Specific Interface Elements 
This section describes the Umler-specific interface elements. 

Umler Application Menu 
Exhibit 3 show the Umler application menu. 

Exhibit 3. Umler Application Menu(split for readability) 

 

The Umler application menu provides the following functions: 

Exhibit 4. Umler Application Menu Functions 
Menu Item Function 
Home Goes to the Umler Welcome page. 
Query Opens the Query menu. 
Maintenance Opens the Maintenance menu. 
Upload/Download Opens the Upload/Download menu. 
Railinc Admin Functions Opens the Railinc Admin Functions menu. For Railinc 

Administrators only. 
Account Administration Opens the Account Administration menu. 
Contact List Opens the FindUs.Rail application. 
Component Registry Opens the Component Registry menu. Described in the 

CEPM User Guide (see  References). 
Help Opens online help for the displayed page. 
References Opens the Umler References page in Railinc.com. 

 Opens a Display Unit Lookup in a new window. 

 
Umler Checkbox Toggles 
On certain pages, Umler uses a checkbox to modify the appearance or display of data. These 
include: 

 Use Spanish for Error Messages and Properties—check to toggle to Spanish language 

 Show database values—check to show unformatted database values 

 Differing elements only—check to differences values (used in Compare Equipment) 

 Flat View—check to display truck components grouped by element in location order 

Unchecking the check box returns the data to its default appearance. 
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Umler Command Buttons 
Umler uses some application-specific command buttons. 
Exhibit 5. Umler-Specific Command Buttons 

Name Function 
Accept Accepts a pending access right granted by another company (Exhibit 225). 
Add Equipment 
Right 

Opens the Equipment Access Right page (Exhibit 202). 

Add Inspection 
Right 

Opens the Inspection Access Right page (Exhibit 205). 

Add Pool Right Opens the Pool Access Right page (Exhibit 200). 
Add View 
Confidential 
Data Right 

Opens the View Confidential Data Access Right page (Exhibit 222). 

Assign to 
Profile 

Opens the Manage Security Profiles (Exhibit 210) 

Assign to User Opens the Intra-Company User List (Exhibit 227) 
Clone Clones an existing security management profile (Exhibit 210). 
Clone Rights  Selects the user whose rights are being cloned. (Exhibit 208) 
Clone Rights 
from Another 
User 

Opens the Select Access Right Source page (Exhibit 208). 

Collapse All Causes table structure to collapse to headings only. Used with + and - icons 
Confirm Clone 
Rights 

Applies cloned rights to the recipient (user). (Exhibit 209) 

Continue Authorizes charges for downloadable queries (Exhibit 31). 
Count 
Equipment 

Provides an equipment count for rights being assigned to a user. 

Decline Declines a pending access right granted by another company (Exhibit 225). 
Element 
Selection 

Toggles back to the Select Elements for Update page for Modify Multiple 
Equipment Units (Exhibit 96). 

Estimate query 
cost 

Use to estimate cost of a billable CSV download query (Exhibit 31). 

Expand All Causes table structure to expand to headings and subheadings only.  
Go While in view by location after incrementing the component count, adds an 

additional component location. (Exhibit 92) 
Grant Access 
Rights 

Opens the Update Access Rights page for the selected company  
(Exhibit 220). 

Grant Profiles Opens the Manage Security Profiles page for the selected company  
(Exhibit 223). 

Relinquish Surrenders a previously-accepted right from another company (Exhibit 226)  
Restore Restores (activates) a deleted notice (Exhibit 174 and Exhibit 175) 
Revoke Revokes access right granted to another company (Exhibit 220) or a 

security profile granted to another company (Exhibit 223). 
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Name Function 
Show 
Equipment 

Shows list of equipment assigned to a specific pool (when viewing a pool 
header). See Exhibit 49. 

Switch View Toggles Equipment details page (e.g., modify, etc) to show components by 
physical location on car. (Exhibit 91 and Exhibit 92) 

Transfer Requests (and confirms) the transfer of specified  access rights from one 
company to another (Exhibit 246). Railinc Administrators only. 

 
Umler Icons and Indicators 
Umler uses application-specific icons and indicators to assist the user: 

Exhibit 6. Umler-Specific Icons 
Icon Description 
 Umler-Specific Icons 
 ETC Generation field 
 Mandatory Element field 
 Rating field 

 Identifies blue card elements 
 Element in conflict indicator. Record needs attention to remove the conflict 
 Copy entry in field to all fields below (notably for Inspections), or change query 

results display order (move selected item down) 
 Move entry into field at right (Query Output Attribute options) 
 Move entry into field at left  (Query Output Attribute options) 
 Change query results display order (move selected item up) 
 Assigns selected security profile to user ID 

 Assigns all available security profiles to user ID 
 Unassigns selected security profile from user ID 

 Unassigns all security profiles from user ID 
+ Expands directory (table) structure 
- Collapses directory (table) structure 
 Calculates due date for related date fields (Inspections). 

 Copy entry in field to all fields below (in Modify Multiple Equipment) 
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Getting Started 
The Umler application is accessed using the Railinc Single Sign On (SSO), which can be 
accessed from the Railinc portal at http://www.railinc.com. The SSO log in is located at the upper 
right of the page. Refer to Register to Use Railinc SSO on page 9. 

Register to Use Railinc SSO 
 Each Umler user must register to use Railinc Single Sign On. It is beyond the scope of this 
document to describe the use of Railinc Single Sign On. Refer to Railinc SSO and Launch Pad 
User Guide. 

Once SSO registration is complete, the user must request access to Umler within SSO.  

Requesting Umler Access 
After authorization to use Railinc SSO is received, the user must request general access to Umler 
following instruction in the Railinc SSO and Launch Pad User Guide. 

When e-mail notification of access to Umler is received, the user can log on and begin using 
Umler. Refer to Logging In on page 9. 

Note: Access to certain functions within Umler are handled by the user’s local Umler 
administrator who has the SSO rights to specify local Umler user’s tasks (and menu 
items). Some advanced Umler tasks are billable from Railinc to the requesting road, so 
access is carefully controlled via SSO. 

 

Logging In 
To log into Umler: 

1. Open the browser. 

2. Open the Railinc portal at http://www.railinc.com. 

3. Log in to SSO. The Launch Pad is displayed. 

4. Select Umler/EMIS. 

a. If the user is authorized to act on behalf of just one company, the Umler Welcome page is 
displayed (Exhibit 8). 

b. If the user is authorized to act on behalf of more than one company, the Select Your 
Company page is displayed (Exhibit 7). 

http://www.railinc.com/
https://www.railinc.com/ssodoc/help/SSOUserGuide.pdf
https://www.railinc.com/ssodoc/help/SSOUserGuide.pdf
https://www.railinc.com/ssodoc/help/SSOUserGuide.pdf
http://www.railinc.com/
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Exhibit 7. Select Your Company 

 
• Scroll to and check the radio button beside the desired company and select Select. 

The Umler Welcome page is displayed (Exhibit 8). 

Note: Using a Find command (Ctrl+F) is generally faster than scrolling. 
 

Exhibit 8. Umler Welcome 

 . . . 
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Functions on this page include:  

• Check the box under the information window to view error messages, page titles, 
instructions, and command buttons in Spanish. 

• Selecting an Umler application menu item (refer to Exhibit 4). 

• Use the Single Equipment Lookup function as described in Single Equipment Lookup on 
page 11. 

• View/update equipment in conflict, select the Equipment units in conflict link. See 
View/Update Equipment Units in Conflict on page 11. 

• Send an e-mail to the user’s company (MARK) Umler contacts. 

• Search for other company’s contacts. 

Single Equipment Lookup 
While on the Welcome page, type an equipment ID in the Single Equipment Lookup text box and 
select OK. The Single Equipment Lookup page is displayed (Exhibit 9). 

Exhibit 9. Single Equipment Lookup 

 

This page is for viewing only. Select the Lookup tab to perform another lookup. 

To exit the page, select Done to return to the Welcome page, or select an Umler application menu 
item (refer to Exhibit 4). 

View/Update Equipment Units in Conflict 
When the user selects the Equipment Units in Conflict link, a query with those units is 
automatically executed (Exhibit 10). 
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Exhibit 10. Equipment Units in Conflict Auto Query 

 

Use the Equipment ID link to display the unit, or select the checkbox beside the unit(s), and if 
authorized, choose Modify Equipment from the Action drop-down to edit those units in conflict. 
Refer to Exhibit 30. Refer also to Modify Single Equipment on page 68 for modification 
instructions. 

E-Mail Umler Administrators for MARK 
To e-mail an Umler administrator for the logged on mark, select the name link in the contact 
column. An e-mail for that administrator is opened. Indicate the Umler needs and send the e-mail. 

Find Other Company Contacts 
When the user selects the Click here link at the bottom of the Home page, the FindUs.Rail 
application opens. Refer to Contact List on page 179 for additional information. 

Logging Off 
On any Umler page, select the sign out link at the upper right of the page. The Railinc SSO login 
page is displayed. 

Note: If the SSO Login is still needed for other SSO application, select the user services link 
instead, which closes Umler and returns to the SSO Welcome page where other 
applications can be selected. 
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Query 
When the user selects Query on an Umler page, the Query menu is opened (Exhibit 11). 

Menu & Options 
Exhibit 11. Query Menu 

 

Exhibit 12 describes the tasks available on the Query menu. 

Exhibit 12. Query Menu Items and Descriptions 

Menu Item Description 
Display Unit Allows the user to view the entire Umler record for a specified equipment ID. 

Equipment Query Allows the user to query for equipment unit information. Provides access to saved 
queries. 

Car Management 
Query 

Allows the user to search for specific pools and equipment in order to view pool 
header and assignment data and perform edits. 

Transaction Log The transaction log provides a history of all activity (related to equipment and 
pool data) successfully applied to the system. This page provides a search engine 
that allows the user to query transaction records by various criteria such as 
transaction type and equipment group.  The user can view the details of found 
transaction records. 

Inspection History Allows a user to request inspection history of equipment or by inspection types. 

Historical Lineage 
Query 

Allows a user to request and view a lineage query for a single piece of equipment. 

Equipment Unit 
Comparison 

Allows a user to view the differences between any two pieces of equipment in the 
same equipment category. 
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Display Unit 
This function is used to view all details of an Umler record for a specified equipment ID.  Based 
on user permissions, some confidential fields may not be displayed. To display a record: 

1. Select Display Unit on the Query menu. The Display Unit page is displayed (Exhibit 13). 
Exhibit 13. Display Unit 

 

2. Type in the desired Equipment ID and select Submit.  The Display Unit Lookup Results page 
is displayed (Exhibit 14). 

Note: If the Equipment ID submitted is NOT valid, an error message is displayed. 
 

Exhibit 14. Display Unit Lookup Results (default expanded view) 

 

Note: This page is for viewing only. 
 

• Scroll the table using the scroll bar or the navigation links above the table 



Umler® Query 
Display Unit 

 

Revised December 2013 15 Umler Version 4.8 

• Use the Collapse All button to collapse the table to headings only (Exhibit 15): 

– General 
– Weight 
– Dimension 
– Specification 
– Feature 
– Cost 
– Blue Card (locomotive only) 
– Car Management 

– Train Service 
– Truck Components 
– Draft System Components 
– Unit Segment Components 
– Intermodal 
– Miscellaneous 
– Inspection 
– Default Presentation Group 

 

• Use the Expand All button to fully expand the table 

• Use the + and - icons beside the headings to open or close them individually 

• Check Show database values to see unformatted database values (this is a toggle—
uncheck to return to the formatted view) 

• Check Flat View to see Components grouped by similar element for easier comparisons 
(Exhibit 16) 

• Select the Equip PDF link to open a printable version of the record in another 
window/tab. The PDF can be saved or printed. To return, close the PDF window/tab. 

• Select the Equipment Health View link to open the Equipment Health View (EHV) 
portal (see the Equipment Health View User Guide for details). 

• For locomotives, select the Blue Card PDF link to display a PDF version of a blue card 
Locomotive Inspection and Repair Record (see Create Blue Card PDF)  

• Select the Lookup tab to submit a different Equipment ID 

Exhibit 15. Display Unit Lookup Results (collapsed view) 

 

https://www.railinc.com/rportal/alf_docs/EHMS/EHMS_EHVUserGuide.pdf
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Exhibit 16. Display Unit (Flat View) 

 

Note: The same elements (e.g., B252)  are listed in component location order (B-brake end, C-
middle component, D-next component, and A-nonbrake end). 

 
When finished viewing the record, select Cancel, or select another Umler application menu item 
(refer to Exhibit 4). 

Create Blue Card PDF 
For locomotives, the Display Unit Lookup Results page contains an additional link to create a 
Blue Card PDF. To display a Blue Card PDF: 

1. Select Display Unit on the Query menu. The Display Unit page is displayed (Exhibit 13). 

2. Type in the desired Equipment ID of a locomotive and select Submit. The Display Unit 
Lookup Results page for a locomotive is displayed (Exhibit 17). 
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Exhibit 17. Display Unit Lookup Results (for a locomotive) 

 
3. Select the Blue Car PDF link. Select to either Open or Save the file. When opened the Blue 

Card is displayed as a PDF (Exhibit 18). 
Exhibit 18. Blue Card PDF 

 
4. As desired, use the options with the PDF Viewer to print the Blue Card. 
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Equipment Query 
The Equipment Query allows the user to search for equipment unit information. The user can also 
save and use saved queries. 

Note: Choosing unique or precise criteria provides results in less time. Take a rifle, rather than 
a shotgun approach to queries. If looking for a single equipment with limited information, 
consider the Single Equipment Lookup on the Welcome page (refer to Single Equipment 
Lookup on page 11. 

 
WARNING: Downloading CSV queries is a billable function with a per record charge. Ensure 

a company administrator has authorized download charges before committing a 
CSV download. With this version of Umler, the user can predetermine charges 
before executing the download. See Export Query Results to CSV on page 28. 

 
To search for equipment: 

1. Select Equipment Query on the Query menu. The Equipment Query page is displayed 
(Exhibit 19 and Exhibit 22). 

Exhibit 19. Equipment Query (top) 

 

The third tab at the top of the page shows saved equipment queries. See Viewing Saved Queries 
on page 31 and Save Query on page 32. 

2. Complete the desired search criteria. At least one search parameter is required to perform a 
search. *Red fields are mandatory. 
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Field Descriptions for the top of the page are shown in Exhibit 20: 

Exhibit 20. Equipment Query Field Descriptions 

Field Description 

Equipment ID(s) Type the specific equipment ID and number (e.g., abcd123) or search with 
a range (e.g., abcd123-999) or a wildcard. See Exhibit 21 for more 
information. 

Pool ID 
 

Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 21 for more information. 

Note: Search for all unassigned equipment using pool ID = 0000000. 
Equipment Group(s) Used to indicate the general equipment group being sought. Valid values: 
 • Box 

• Gondola 
• Hopper 
• Tank 
• Flat 

• Intermodal Flat 
• Vehicular Flat 
• Chassis 
• Container 
• Trailer 

• Steel Wheel Set 
• Locomotive 
• Passenger 
• Misc 
• EOT Device 

Equipment Type Codes 
 

To Query by complete codes, select the Query by complete codes radio 
button and type the complete code (e.g., M500) in the single blank input 
field. To Query by partial codes, select the Query by partial codes radio 
button, and use the four drop-down fields displayed to select partial code 
values (one alpha and three numeric). 

 

Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
Umler Data Specification Manual. 

*Include Equipment 
Restricted in 
Interchange 

This option allows you to choose to include or not include restricted 
equipment in an interchange. Restricted equipment units are those in a 
conflict status. Default is Yes. 

EIN(s) Equipment Identification Number. . Uniquely identifies equipment in 
Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN (unless equipment is rebuilt with new built date). 

Company-Specific 
Equipment Group(s) 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Refer to Company-Specific 
Equipment Groups on page 106. 
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Exhibit 21. Equipment ID Formats/Delimiters/Wildcards 
Example Expected Outcome 
ABC 100, ABC 101, ABC 105 This range would include 3 IDs 
ABC 100–109 This range would include 10 IDs 
ABC 100–109, ABC 112, ABC 120–129 This range would include 21 IDs 
ABC100,121,132 Equipment Initials is optional in a range 
ABC100–110,121,132 Dash and commas can be combined without Equipment Initials in a 

range. This range has 13 IDs 
ABC 200 
ABC 204 
ABC 208 

New line is a acceptable delimiter in any of the formats above 

ABC 300;ABC 304;ABC 306  Semi-colon is a acceptable delimiter in any of the formats above 
ABC 300.ABC 304.ABC 306  Dot is a acceptable delimiter in any of the formats above 

ABC 000000000* Wild card Character is *. This range will have 10 IDs 
Valid Delimiters: • Dot 

• Colon 
• Semi-colon 

• Comma 
• New line/Carriage Return 

• Single quote 
• Space (with solid IDs only)  

 
Exhibit 22. Equipment Query (bottom) 

 

Field Descriptions for the bottom of the page are shown in Exhibit 23: 

Exhibit 23. Equipment Query Field Descriptions (cont’d) 

Field Description 

Equipment Initials The initials stenciled on the specified equipment. 
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Field Description 

Umler Owner The Umler owner of the specified equipment. 
EMIS Company The parent company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Mark Owner The stenciled mark owner for the specified equipment. 
Status/No Status To search by specified equipment statuses, select the Status radio button 

and then the desired status types listed (Active, Inactive or Pre-registered). 
Select the No Status radio button to search for equipment without a status. 
Otherwise, the default is all statuses. 

Confidential Element 
Search (up to three 
allowed) 

 

The Element Name drop down allows 
you to restrict your equipment search to 
a specific element. 

 

 

Use the Qualifier drop down to select 
the Boolean operator to be used in 
combination with the entered Element 
Values. Use “Between” to obtain results 
using two input values (e.g., weight 
range, date range). 

 Compare to another element—INSERT 
 Element values—This may be a height, length, width, weight, or other 

number, Yes/No, etc. If a date, a format hint is provided (YYYYMMDD) 
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Field Description 

Element Value Criteria 
(up to three allowed)  

 

The Element Name 
drop down allows you 
to restrict your 
equipment search to a 
specific element.  

 

 

Use the Qualifier drop down to select the 
Boolean operator to be used in combination 
with the entered Element Values. Use 
“Between” to obtain results using two input 
values (e.g., weight range, date range). 

 Compare to another element—INSERT 
 Element values—This may be a height, length, width, weight, or other 

number, Yes/No, etc. If a date, a format hint is provided (YYYYMMDD) 
 

Note: Using Element Value Criteria/Values to View Conflicts:  
a. Select Date of Original Conflict from the Element Name drop-down. 
b. Select Greater than or Equals from the Qualifier drop-down. 
c. Type 20090101 in the Element Values fields. 

 
3. Set the *Output to: drop-down to browser to have the search results displayed in the browser 

(default). Otherwise, select CSV (comma separated values). See Warning on page 18.  

4. (For browser only) Set the *Maximum Number of Results field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

5. (Optional) Select the Customize Query Output tab to specify what data attributes should be 
included in the results displayed, and how those results should be sorted. See Exhibit 24. 
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Exhibit 24. Equipment Query (Customize Query Output) 

 

a. Select a needed attribute in the Available Attributes table and select the right arrow ( ) 
to move it into the Selected Attributes field. For multiple selection, press Ctrl while 
making selections and move all at once. 

b. Remove all unneeded attributes from the Selected Attributes field, by selecting and 
pressing the left arrow ( ). 

c. Use the up ( ) and down ( ) arrows to adjust the order of the output. The top attribute 
appears as the first (left) column in the results table. 

d. (Optional) Use the Sort By fields to sort results for any attributes included in the results. 
The first Sort By is the primary sort. The other two Sort by fields are the secondary sort 
and the tertiary sort. The default sort is the first three attributes listed in ascending order. 
In Exhibit 24, the user might want the data sort by Lessee as a primary sort (to get 
potential contacts clustered together in the output). Lessee would then be selected for the 
first Sort By attribute. 

e. If needed, select the Basic tab to return to the main query input page. 

6. Verify all criteria and output options have been specified, as shown in Exhibit 25, Exhibit 26, 
and Exhibit 27. 
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Exhibit 25. Equipment Query Example (top) 

 

Exhibit 26. Equipment Query Example (bottom) 
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Exhibit 27. Equipment Query Example (Customize Query Output) 

 

7. Select one of the processing options shown in Exhibit 28. 

Exhibit 28. Query Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See View 

Query Results on page 26 and Export Query Results to CSV on page 28. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria. See Exhibit 36. 
Save Saves the query. Opens the Save Query Attributes panel (Exhibit 38). 
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View Query Results 
If Browser was selected for output, and Search selected, the Equipment Query Results page is 
displayed (Exhibit 29). 

Exhibit 29. Equipment Query Results 

 

View Details 
To view details for a particular equipment, select its Equipment ID Link. The Display Unit 
Lookup Result page is displayed (refer to  

Exhibit 14). Select Cancel on the detail page to return to the query results. 

Revising a Search 
While viewing search results online, select the Search Criteria tab to modify search criteria 
values and then resubmit. 

Requesting Other Actions 
Other actions can be taken for selected equipment by selecting an action from the drop-down 
(Exhibit 30) and selecting OK. The various actions are described in other sections of this guide. 

• Add to Pool (refer to Exhibit 128) 
• Air Brake Test (refer to Exhibit 131) 
• Autorack Certification (refer to Exhibit 131) 
• Autorack Inspection (refer to Exhibit 131) 
• Autorack Repair (refer to Exhibit 131) 
• Car Grade Inspection (refer to Exhibit 131) 
• Change Equipment Group (refer to Exhibit 102) 
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• Clone Equipment 
• Delete Equipment 
• Door Lube Inspection (refer to Exhibit 131) 
• Locomotive Air Brake Inspection (refer to Exhibit 131) 
• Locomotive Annual Inspection (refer to Exhibit 131) 
• Locomotive Cab Signals Inspection (refer to Exhibit 131) 
• Locomotive Inspection Due Date Update (refer to Exhibit 131) 
• Locomotive Quarterly Inspection (refer to Exhibit 131) 
• Locomotive RCL Inspection (refer to Exhibit 131) 
• Locomotive Storage Event (refer to Exhibit 131) 
• Modify Equipment (refer to Exhibit 91) 
• Reflectorization Event (refer to Exhibit 131) 
• Remove from Pool (refer to Exhibit 129) 
• Remove Lessee (refer to Exhibit 118) 
• Send to Conflict Check (for use by Railinc Admin users only) 
• Update Equipment Maintenance Party (refer to Exhibit 107) 
• Update Equipment Management Codes (refer to Exhibit 120) 
• Vehicular Flat Car Certification (refer to Exhibit 131) 

Exhibit 30. Action Drop-Down (in Query Results) 

 

Note: Send to Conflict Check is available to Railinc Admin users only. 
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Export Query Results to CSV 
PreDownload Charge Calculation 
If the user chose CSV file for output, Umler shows a panel that offers the user an opportunity to 
see the amount that will be automatically billed to their company before executing the download 
(Exhibit 31). 

Exhibit 31. Notification of Chargeable Action 

 

Select Estimate query cost. Umler calculates the charge that would apply and displays it in the 
message area of the Equipment Query page (Exhibit 32). 

Exhibit 32. Cost Message for CSV Download 

 

If the cost is acceptable/authorized, reset the Output field to CSV, select Search, and select 
Continue when the Notification of Chargeable Action panel is redisplayed. Then continue with 
Downloading the File on page 28. 

Note: Charges are billed when the user selects Continue. 
 

Downloading the File 
If the user chose CSV file for output and selected Continue on the Notification of Chargeable 
Action panel (Exhibit 31), Umler shows a dialog box for the user to specify whether to open 
(view) or save the CSV file (Exhibit 33). 
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WARNING: Do NOT select Cancel. If the user selects Cancel, the download is canceled, but 
charges will already have been made to the user’s company. 

 
Exhibit 33. File Download for CSV Output 

 

• If Save is selected, The Save As… panel is displayed (Exhibit 34). This is the 
recommended choice to avoid accidental file loss. 

Exhibit 34. Save As… for CSV Query Output 

 

Choose the file location and file name and select Save. The file is saved and can be 
opened using MS Excel (Exhibit 35).  

• If Open is selected, the output appears as shown in Exhibit 35. 

WARNING: User must save an opened file to avoid additional charges if the opened 
file is accidentally closed (or the spreadsheet software closed). 
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Exhibit 35. CSV Query Output in MS Excel 

 

Note: If the file was not saved earlier, it can be saved directly from Excel. 
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Request Counts for Query 
If the user selects Count, the query is executed, but only the number of records matching the 
criteria is displayed (Exhibit 36). No details are provided. This can be used to provide counts to 
purchasing departments for parts ordering, scheduling inspections, or estimating vendor service 
needs, etc. 

Exhibit 36. Equipment Query (with Count results) 

 

If additional details are needed, select Search to execute a normal query. 

Viewing Saved Queries 
When the user selects the Saved Queries tab, the Saved Queries page is displayed (Exhibit 37). 

Exhibit 37. Saved Queries Tab 

 

Select the Query Name link to use values saved in that query. Selecting table heading links sorts 
by that field. Select the Delete link in the Action column to delete a saved query. By default, 
users see their own queries, but can check the All Saved Queries radio button to view all for their 
company. 
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Save Query 
Queries that might be used again can be saved. Saving queries helps save input time and ensures 
consistent results (e.g., doing the same query across several roads). When a query is saved, the 
Save Query Attributes page is displayed (Exhibit 38). 

Exhibit 38. Save Query Attributes 

 

Type a name in the Query Name field. Optionally, type a description in the Query description 
field that make selecting the correct query easier. Select Save. The query is saved, and the 
Equipment Query page is redisplayed with the saved query in the top table. 

Reuse a Query 
To reuse a saved query, select the Saved Query tab. Select the Query Name link. The page (all 
tabs, if used) is populated with the saved query. Make required changed (e.g., date changes, or 
RR changes, etc., and select a processing option (Exhibit 28). 

Delete a Query 
To delete a saved query, select the Saved Query tab, and select the Delete link to the right of the 
query in the Action column. 
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Car Management Query 
The Car Management Query function is used to search for specific pools and equipment in order to 
view pool header and assignment data and perform edits. 

Equipment View 
To do a Car Management Query: 

1. Select Car Management Query on the Query menu. The Pool/Equipment Search page is 
displayed (Exhibit 39). 

Exhibit 39. Pool/Equipment Search 

 

2.  Set View to Equipment View for equipment management. Otherwise, leave set to Pool View 
for pool management (for Pool View, see Pool View on page 38). 

3. Complete the desired search criteria. At least one search parameter is required to perform a 
search. 

Warning: Use of both Equipment IDs and Pool IDs is not allowed. Specify one or the other. 
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Field Descriptions for the page are shown in Exhibit 40: 

Exhibit 40. Car Management Query Field Descriptions 

Field Description 

Company-Specific 
Equipment Group(s) 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Use the lookup icon  
( ) to open the Search for Company-Specific Equipment Groups page 
(Exhibit 148). Refer to Company-Specific Equipment Groups on page 106. 

Pool ID Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 21 for more information. 

Note: Search for all unassigned equipment using pool ID = 0000000. 
Description General description of the pool (20 characters max). 
Reporter Assigned alphabetic reporting mark of the carrier reporting for non-

mechanized operators that have made such an agreement with the reporting 
road (4 characters max). 

Operator Assigned alphabetic reporting mark of the actual operator of a specific pool 
(4 characters max). 

Loading Location The actual shipper loading point or plant location or railroad holding point.  
Must be a valid SPLC location (19 characters max). Use the lookup icon  
( ) to open the Station Look Up page (Exhibit 41). 

State/Province 
(Loading) 

Indicates the state or province where the pool is located. This is 
automatically populated with Station Lookup results. 

Held-Short Location Actual location where equipment is held-short if not able to be placed at 
the loading location.  Must be a valid SPLC location (19 characters max). 
Use the lookup icon ( ) to open the Station Look Up page (Exhibit 41). 

State/Province 
Held-Short 

Indicates the State/Province where the equipment is held-short. This is 
automatically populated with Station Lookup results. 

Pool Maintenance Code 0 = Not Applicable 
1 = Auto/truck loading multi-level flat cars 
2 = Specially equipped chain tie-down cars 
3 = Equipped with cross bar interior restraining devices 
4 = Automobile parts and bulkhead equipped equipment 
5 = Automobile and truck frame equipment 
6 = Flat cars equipped for saddleback loading 
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Field Description 

Pool Type Used to identify a type of railroad pool assignment: 

C = Equipment assigned to a specific shipper at a specific location 
G = Contaminated cars 
J = Equipment assigned to an agent 
N = Similar to the “C” Pool, except, the equipment is not assigned to a 

specific shipper or loading point (National Pools). 
O = Equipment assigned to Recall pools 
P = Pool comprised of equipment assigned to accommodate a specific 

commodity. 
T = Pool comprised of equipment assigned to an agent.  

Extended Description More detailed description of the pool (80 characters max). 
Equipment ID(s) Type the specific equipment IDs (e.g., abcd123) or search with a range 

(e.g., abcd123-999 or a wildcard). See Exhibit 21 for more information. 
Equipment Group(s) Used to indicate the general equipment group being sought. See Equipment 

Group(s) in Exhibit 20. 
Equipment Type Code(s) Alphanumeric code (one alpha and three numeric) used to designate a 

specific type of equipment and attributes. 
Mechanical Designation Alphabetic AAR code assigned to the physical description of the unit. See 

Umler Data Specification Manual. 
 

Station Lookup 
When the lookup icon is selected for either Location field, the Station Look Up page is displayed 
(Exhibit 41). 

Exhibit 41. Station Look Up 

 

a. Select a qualifier for the location text. Valid values include: 

• Begins With 
• Contains 
• Ends With 
• Exact Match 

b. Type text in the Location field provided. 

c. (Optional) Select a State/Province from the drop-down. 

d. (Optional) Type in a known SCAC. 
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e. Select Search. The Station Look Up Results page is displayed (Exhibit 42). 

Exhibit 42. Station Look Up Results 

 

f. Select the radio button beside the correct location and select OK. The Pool/Equipment 
Search page is redisplayed (Exhibit 39) with the location and State/Province field 
showing the selection. 

4. Set *Output to: to CSV, if needed, or leave set to Browser (default). See Warning on page 
18. 

5. Set *Maximum Number of Results (1000 is default). 

6. Select one of the following processing options: 

Exhibit 43. Car Management Query Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See 

Browser Output or CSV Output. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria (similar to Exhibit 36). 
 
7. View either browser or CSV output results (Exhibit 44 or Exhibit 45). 
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Browser Output 
If Browser was selected for output, results appear as shown in Exhibit 44. 

Exhibit 44. Pool/Equipment Search Results (Equipment View) 

 

Abbreviations used in the results table include: 

• EG = Equipment Group 
• ETC = Equipment Type Code 
• MD = Mechanical Designation 
• UR = User Empty Routing Instruction 
• SG = System Empty Routing Instruction 
• PC = Pool Control 
• MR = Mechanical Restriction 
• MRR = Mechanical Restriction Reason 
• TC = Umler Transportation Code 
• TCC = Umler Transportation Condition Code 

To view details for a particular equipment, select its Equipment ID link. The Display Unit 
Lookup Result page is displayed (refer to  

Exhibit 14). Select Cancel on the detail page to return to the query results. 

To take actions for listed equipment, refer to Requesting Other Actions on page 26. 
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CSV Output 
If CSV was selected for output, results appear as shown in Exhibit 45. Refer to Export Query 
Results to CSV on page 28 for instructions on choices for saving or opening the CSV file. 

Exhibit 45. Pool/Equipment Search Results (CSV results opened in Excel) 

 

Pool View 
If the user elects to do a pool view, use query criteria as described in Equipment View on 
page 33, but leave the View drop-down set to Pool View. Results can be to the browser or CSV 
(or a count).  

Note: To view all Pool Headers, select Search without entering any criteria. When entering 
Pool ranges, do not use a range larger than 10,000. 

 
Browser Output 
If Browser was selected for output, results appear as shown in Exhibit 46. 

Exhibit 46. Pool/Equipment Search Results (Pool View) 
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The only action currently available from this page is Delete Pool. To delete a pool header, check 
the boxes beside the pools to be deleted and select OK. See Delete Pool Header on page 85 for 
more information. 

To view a pool header, select its link. The View Pool Header page is displayed (Exhibit 47). 

Exhibit 47. View Pool Header 

 

Select one of the following options: 

Exhibit 48. View Pool Header Processing Options 
Show Equipment Opens the Assigned Equipment page for viewing (Exhibit 49). No 

actions are available on this page. Select Done to return to the View 
Pool Header page. To remove individual equipment from a specific pool, 
use either an Equipment Query or a Car Management Query (Equipment 
View) with the Pool ID as criteria.  

Edit Opens the Update Pool Header page (Exhibit 50). See Update Pool 
Header on page 40. 

Done Returns to the search results page (Exhibit 46). 
 

Exhibit 49. Assigned Equipment 
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Update Pool Header 
After a pool view query is performed, a pool ID link selected, and a pool header is being viewed: 

1. Select Edit. The Update Pool Header page is displayed (Exhibit 50). 

Exhibit 50. Update Pool Header 

 

2. Update fields as needed. Refer to Exhibit 116 for field descriptions. 

3. (Optional) Choose the Future radio button to delay the pool addition to a future date. The 
page expands with an On Future Date field. 

Exhibit 51. Future Date Fields 

 

Note: Pool-related actions assigned a future date can be modified. See Manage Future 
Transactions on page 129. 

 
a. Use the calendar picker ( ) to select the future date. 

Note: Future date must be from 2 days (48 hours) to a maximum of 30 days. 
 

b. (Optional) Add a Transaction Description to make the future work easier to identify when 
using the Maintenance>Manage Future Transactions function. 
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4. Select one of the options shown in Exhibit 52.  

Exhibit 52. Update Pool Header Processing Options 
Validate Validates data before submission to facilitate error correction.  
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 140 is displayed. After successful 
submission of changes, select OK to return to the query list.  

Suspend Saves the edit input for completion later. Opens the Suspend Work page (similar to 
Exhibit 82). See Suspended Work on page 127 to resume the Pool Header Edit task. 

 



Umler® Query 
Transaction Log 

 

Revised December 2013 42 Umler Version 4.8 

Transaction Log 
The Transaction Log function allows users to see a list of transactions for specified criteria (e.g., 
date range, user ID, Equipment IDs, Pool IDs, transaction types, etc.). 

To view a transaction log: 

1. Select Transaction Log on the Query menu. The Search Transaction Log page is displayed 
(Exhibit 53 and Exhibit 55). 

Exhibit 53. Search Transaction Log (top) 

 

2. Complete the desired search criteria.  At least one search parameter is required to perform a  
search. Mandatory fields are indicated with an asterisk (*) and red font. 

Field descriptions for the top of the page are shown in Exhibit 54. 

Exhibit 54. Transaction Log Field Descriptions 

Field Description 

*Output to: Select CSV from drop-down to have results saved/displayed as a CSV file. 
Default is Browser. See Warning on page 18. 

*Maximum Number of 
Results (Browser 
Output Only): 

Maximum number of result records you want returned (100, 500, 1000, 
5000). Default is 1000. 
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Field Description 

*Date/Time range Search for transactions occurring between the specified starting date/time 
and the specified ending date/time.  Remember to select either AM or PM 
with the available radio buttons. 
• Starting Date/Time defaults to 12:01 AM of the previous day’s date. 
• Ending Date/Time defaults to 11:59 PM of the current day’s date. 
Check Search All Dates to ignore date criteria. 
Note: All notice times are recorded in Eastern Time.  

*Equipment ID(s) Type the specific equipment IDs (e.g., abcd123) or search with a range 
(e.g., abcd123-999) or a wildcard. See Exhibit 21 for more information. 

*Company-Specific 
Equipment Groups 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Use the lookup icon  
( ) to open the Search for Company-Specific Equipment Groups page 
(Exhibit 148). Refer to Company-Specific Equipment Groups on page 106. 

Transaction Type(s) Search for transactions related to the following: Pool Header, Pool 
Assignment, Equipment Characteristics, Inspections and Car Grades. 

User ID(s) Search for transactions created by specific users by entering User IDs in 
this field. Separate multiple IDs using the delimiters shown in Exhibit 21. 
To search for intra-company user IDs, see Manage Intra-Company User 
Access Rights on page 141. 

State(s) Select either Normal or Nullified. Nullifying an event identifies it as 
having been submitted in error. Selecting Nullified finds transactions that 
had been nullified. 

Equipment Type 
Code(s) 

Search for transactions related to equipment with the specified equipment 
type code(s). For example, M500. 

Equipment Group(s) Used to indicate the general equipment group being sought. See Equipment 
Group(s) in Exhibit 20. 
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Exhibit 55. Search Transaction Log (bottom) 

 

Field descriptions for the bottom of the page are shown in Exhibit 56. 

Exhibit 56. Transaction Log Field Descriptions (cont’d) 

Field Description 

Pool ID Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 21 for more information. 

Note: Search for all unassigned equipment using pool ID = 0000000. 
Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
Umler Data Specification Manual. 

Company ID(s) Search for transactions related to specified company ID(s). 
EIN(s) Equipment Identification Number. Uniquely identifies equipment in 

Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN. 
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Field Description 

Element value criteria Two sets are provided (for Transaction and Previous values). 

• Use the drop-down to select an 
Element Group: 

 

• Use the drop-down to select an 
Element (from selected Group): 

 

• Type a Transaction Value to input a specific element qualifier, or 
check the All Values checkbox without using a qualifier. 

Ownership Control 
Criteria 

Check one of the two radio buttons provided: 
• Results reflect current ownership conditions 
• Results reflect ownership conditions at time of transaction 

Equipment Initials The initials stenciled on the specified equipment. 
Umler® Owner(s) The Umler owners of the specified equipment. 
EMIS Company The EMIS Company that owns the specified equipment. 
Lessee(s) The company leasing the specified equipment. 
Stenciled Mark 
Owner(s) 

The stenciled mark owners for the specified equipment. 

 
3. Select one of the following processing options: 

Exhibit 57. View Transaction Log Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See View 

Transaction Results Online on page 46 or refer to Export Query Results to CSV on 
page 28 for CSV file processing/viewing. 

Count Executes the search and outputs a single line message with the count of transaction 
records meeting the specified criteria. Similar to Exhibit 36. 
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View Transaction Results Online 
If Browser was selected for output, and Search selected, the Transaction Log Search Results page 
is displayed (Exhibit 58). 

Exhibit 58. Transaction Log Search Results 

 

To change criteria, select the Search Criteria tab, edit, and resubmit. 

To view details for a particular transaction, select its ID link (column at left). The Transaction 
Details page is displayed (Exhibit 59). Select Done on the detail page to return to the search 
results. 

To view contact information for the listed Company or User, select their respective links. See 
Exhibit 60 and Exhibit 61. Select Done to return to the Search Results page. 
Exhibit 59. Transaction Details 

 

The only actions available on this example page is to view the Company Contact information 
(Exhibit 60), view User Contact Information (Exhibit 61) or select the Transaction ID to view the 
transaction that generated the one being viewed. 

Exhibit 60. Company Contact Info 

 

Exhibit 61. User Contact Info 
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Inspection History 
This function is used to view inspection history for a specified equipment ID or EIN. To view an 
inspection history for equipment units: 

1. Select Inspection History on the Query menu. The Search Inspection History page is 
displayed (Exhibit 62). 

Exhibit 62. Search Inspection History (top) 

 

2. Complete the desired search criteria. At least one search parameter is required in the first box 
to perform a search. Mandatory fields are indicated with an asterisk (*) and red font. 

Field descriptions for the top of the page are shown in Exhibit 63. 

Exhibit 63. Inspection History Field Descriptions 

Field Description 

Equipment ID(s) Type the specific equipment IDs (e.g., abcd123) or search with a range 
(e.g., abcd123-999) or a wildcard. See Exhibit 21 for more information. 

EIN(s) Equipment Identification Number. Uniquely identifies equipment in 
Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN. 

Company-Specific 
Equipment Groups 

Company-Specified Equipment Groups are private pools of equipment that 
are only available to the company specified. Use the lookup icon  
( ) to open the Search for Company-Specific Equipment Groups page 
(Exhibit 148). Refer to Company-Specific Equipment Groups on page 106. 
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Field Description 

Date/Time range Search for inspections occurring between the specified starting date/time 
and the specified ending date/time.  Remember to select either AM or PM 
with the available radio buttons. 
• Starting Date/Time defaults to 12:01 AM of the previous day’s date. 
• Ending Date/Time defaults to 11:59 PM of the current day’s date. 
Check Search All Dates to ignore date criteria. 
Note: All notice times are recorded in Eastern Time. 

 
Exhibit 64. Search Inspection History (bottom) 

 

Field descriptions for the bottom of the page are shown in Exhibit 65. 

Exhibit 65. Inspection History Field Descriptions (cont’d) 

Field Description 

Inspection Types Select the inspection types wanted for the query. Multiple selections are 
allowed. 

User ID(s) Search for inspections recorded by specific users by entering User IDs in 
this field. Separate multiple IDs using the delimiters shown in Exhibit 21. 
To search for intra-company user IDs, see Manage Intra-Company User 
Access Rights on page 141. 

States Select Normal or Nullified (to see inspections that have been nullified via 
EDI messages). 

System generated Select the Yes or No radio button to include system generated inspection 
records. To clear both radio buttons, select Clear. 

Voided Select the Yes or No radio button to show “voided” inspections. To clear 
both radio buttons, select Clear. 
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Field Description 

Element Value Criteria One criteria set is provided. 

• Use the drop-down to select an 
inspection Element: 

 

• Type a Transaction Value to input a specific element qualifier. 

*Output to Select Browser (Summary) or Browser (Detail) from drop-down. Default is 
Browser (Summary). No CSV is selectable on this page. 

*Maximum Number of 
Results 

Maximum number of result records you want returned (100, 500, 1000, 
5000). Default is 100. 

 
3. Select one of the following processing options: 

Exhibit 66. View Transaction Log Processing Options 
Search Executes the search and outputs to the Browser as requested. See View Inspection 

History Summary Results Online on page 50, or View Inspection History Detail 
Results Online on page 51. 
 

Count Executes the search and outputs a single line message with the count of inspection 
records meeting the specified criteria. Similar to Exhibit 36. 
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View Inspection History Summary Results Online 
If Browser (Summary) was selected for output, and Search selected, the Search Inspection 
History page is displayed (Exhibit 67). 

Exhibit 67. Search Inspection History (Summary Results) 

 

To see details for an equipment ID, select the Timestamp link at left. The detail page for that 
equipment is displayed (Exhibit 68). 

To export the results as a CSV file, select the CSV link at the lower left of the page. Refer to 
Export Query Results to CSV on page 28. 

Exhibit 68. Search Inspection History (details from Summary) 

 

This page is for viewing. Select Done to return to the Search Results Summary page. 
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View Inspection History Detail Results Online 
If Browser (Details) was selected for output, and Search selected, the Search Inspection History 
page is displayed with all details displayed (Exhibit 69). 

Exhibit 69. Search Inspection History (Details List) 

 

To see details for an equipment, select the Timestamp link at left. The detail page for that 
equipment is displayed (Exhibit 68). To move between many pages (30 details per page), use the 
[First/Prev], 1, 2, …, [First/Last] links. 

To export the results as a CSV file, select the CSV link at the lower left of the page. Refer to 
Export Query Results to CSV on page 28. 
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Historical Lineage Query 
This function is used to view all unit identification (entry into system, restenciling, etc.) actions 
for a specified equipment ID or EIN. Based on user permissions, some confidential fields may not 
be displayed. To view lineage for a unit: 

1. Select Historical Lineage Query on the Query menu. The Historical Lineage page is 
displayed (Exhibit 70). 

Exhibit 70. Historical Lineage Query 

 

2. Type in a valid Equipment ID or EIN and select Search. The Historical Lineage Query 
Results page is displayed (Exhibit 71). 

Exhibit 71. Historical Lineage Query Results 

 

This example shows a car that changed ownership and was restenciled. The EIN remains the 
same throughout, but the Equipment ID changes. The most recent lineage action is at the top of 
the table. 

Select the Search Criteria tab to do another query, or select another Umler application menu item 
(refer to Exhibit 4). 

Note: Only one “active” equipment record can exist in the EIN lineage. Having more than one 
equipment ID active for the same EIN may result in a duplicate EIN conflict status for all 
active records. 
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Equipment Unit Comparison 
This function is used to view a comparison of Umler records for two specified equipment units. 
This might be used to: 

• Ensure when an equipment changes ownership and operates for a period of time under 
both IDs, that the most recent information appears in the newest record (e.g., inspections 
or repairs done) 

• Help make a decision between two cars being considered for hire 

Based on user permissions, some confidential fields may not be displayed. To view a comparison 
between units: 

1. Select Equipment Unit Comparison on the Query menu. The Equipment Unit Comparison 
page is displayed (Exhibit 72). 

Exhibit 72. Equipment Unit Comparison (entry) 

 

2. Type the Equipment IDs to be compared in the two text boxes and select Submit. The 
Equipment Unit Comparison page is redisplayed with data for each unit shown side by side 
(Exhibit 73). 

Note: Validation is optional, but performed as part of the submit process. If either 
Equipment ID is invalid, an error message is displayed. 
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Exhibit 73. Equipment Unit Comparison (results expanded—all elements) 

 

Values for the two units appear in two columns with the Equipment ID at the top. Elements with 
different values are outlined and in a lighter color (orange). Component help ID links can be 
different if the cars are different types (as shown in the example). Page navigation is similar to 
that described in Display Unit on page 14. 

Check Differing elements only to restrict the view—“same” elements are removed from view 
(Exhibit 74). Uncheck to return to the regular view. 

Use the Collapse All and Expand All buttons to collapse or expand the table structure. 
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Exhibit 74. Unit Comparison (differences only view) 

 

These pages are for viewing only. When finished viewing the comparison, select Cancel, or 
select another Umler application menu item (refer to Exhibit 4). 
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Maintenance 
Note: To do these tasks, user must have some rights assigned beyond query (Umler default 

permission). See the Company Umler Administrator for assistance. 
 
When the user selects Maintenance on an Umler page, the Maintenance menu is opened 
(Exhibit 75). 

Menu & Options 
Exhibit 75. Maintenance Menu 

 

Exhibit 76 describes the tasks available on the Maintenance menu. 

Exhibit 76. Maintenance Menu Items and Descriptions 

Menu Item Description 
Add/Change/Delete Opens the Add/Change/Delete submenu.  
Car Management Opens the Car Management submenu.  

Inspections Opens the Inspections page, which allows the user to report (or view) 
described inspections. 

Company-Specific 
Equipment Groups 

Opens the Company-Specific Equipment Group submenu. 

Notice Management Displays the Search for Notices page.  Allows the user to search for notices 
based on detailed search criteria, view notices, fix errors related to notices, and 
suppress read, resolved, or unwanted notices. 

Suspended Work Open the Suspended Work page and tasks that have been saved “in progress” 
and allows the user to select and resume work on a suspended task. 

Manage Future 
Transactions 

Displays the Search Future Effective Transaction page which allows the user 
to search for and delete any future effective transactions. 
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Add/Change/Delete 
When the user selects Maintenance>Add/Change/Delete, the Add/Change/Delete submenu is 
displayed. 

Exhibit 77. Add/Change/Delete Submenu 

 

Exhibit 78 describes the options on the Add/Change/Delete submenu. 

Exhibit 78. Add/Change/Delete Submenu Items and Descriptions 

Menu Item Description 
Add Equipment Allows a user to add a new equipment unit to Umler. 

Clone Equipment Allows a user to add single and multiple equipment units by cloning from an 
existing unit. 

Add-Back 
Equipment 

Allows a user to add an equipment unit back into active status from online Umler 
archives. 

Add-Back Multiple 
Equipment 

Allows a user to reactivate multiple equipment units at one time. 

Modify Single 
Equipment 

Allows a user to change elements for a single equipment unit. 

Modify Multiple 
Equipment 

Allows a user to change selected elements for several equipment units in one 
editing session. 

Single Restencil Allows a user to modify a record to reflect restenciling of the piece of equipment. 
Restenciling refers to the act of changing the equipment mark and number that is 
stenciled on the side of an equipment unit. 

Multiple Restencil Allows a user to restencil multiple cars sequentially or following a pattern. 

Change Equipment 
Group 

Allows a user to change an Umler Equipment Group for a single equipment unit. 

Update Equipment 
Maintenance Party 

Allows the user to update the Equipment Maintenance Party. 

Delete Equipment Allows a user to deactivate an Umler record, sending the record to archive. 
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Add Equipment 
The Add Equipment function is used to add new equipment to Umler. This function works well 
for adding multiple equipment with identical element values. For adding multiple equipment with 
significant differences or similar to an existing equipment, the Clone Equipment function can 
save time. 

Note: Use only for new equipment. Equipment with a Prior ID must use the Restencil function. 
  

1. Select Maintenance>Add/Change/Delete>Add Equipment. The Add Equipment page is 
displayed (Exhibit 79). 

Exhibit 79. Add Equipment (Initial entry) 

 

2. Type in the Equipment ID to be assigned for this unit. 

Note: Each road or private mark may have numbering standards in place. The Equipment 
ID must follow normal conventions of  2-4 alpha characters and 1-6 numeric 
characters. For example, BNSF123456.  Multiple IDs can be entered at the same 
time, either on separate lines or separated by commas or a single space. Sequential 
IDs can be entered as a range (BNSF222201-10).  

 
3. Select the Equipment Group from the drop-down. Valid values are: 

Exhibit 80. Equipment Group 
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Note: When adding multiple equipment IDs, only one equipment group is used. Some types 
cannot be changed after entering the new records (e.g., LOCO). If in doubt, add 
equipment units one at a time. Additionally, the clone function can be used for 
identical or similar units. 

 
4. For articulated equipment, indicate the number of articulations in the Connected Unit Count 

field (up to 99). Otherwise, accept the default value of zero. 

5. (Optional) Select Validate to have Umler validate the request. Otherwise continue. 

6. Select Submit. The system checks to make sure the Equipment IDs entered are not already in 
Umler (active or inactive). 

a. If an active ID exists, the add is not allowed. An error message is displayed. 

b. If an inactive ID is found, an information message suggests using Add-Back to reactivate 
the ID. See Add-Back Equipment on page 64. 

c. If the requested IDs are valid, the Add Equipment element entry page is displayed. 

Exhibit 81. Add Equipment (element entry) 

 

Elements shown in the table are based upon the Equipment Type selection made. Mandatory 
elements have the red dot in the Flag field ( ). See Exhibit 6 for other flag icons. 

This page has navigation and display characteristics similar to that described in Display Unit on 
page 14. 
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7. Complete the fields in the entry page table: 

a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help on page 182. 

c. Ensure all mandatory fields have been completed. 

8. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values and displays an error message under the page title and 
displays any element-specific error message in the error column beside the element. 

9. Correct the errors: 

a. Read through all errors. Because many elements are related, correcting a single element 
might correct multiple errors. 

b. Any error regarding Umler rights (equipment, pool, inspection, or view confidential data) 
or SSO company-specific rights (authorization to act for a company) must be addressed 
first. See the Company SSO and/or Umler Administrator. 

c. Some conditional elements become mandatory based on inputs (rather than Equipment 
Type), so complete all new mandatory fields. 

d. Use field help to change invalid values. Select the ID link for the field. See Field Help on 
page 182. 

e. (Recommended) Correct one error at a time and select Validate between corrections. 

10. Select Validate a final time to ensure errors have been corrected. 

a. If errors are still found (or new errors initiated), make necessary corrections and 
revalidate. 

Note: If validation fails after several attempts at correction and revalidation, select 
Suspend to save the work until error corrections can be clearly identified. The 
Suspend Work page is displayed (Exhibit 82). See Suspended Work on page 127 
to resume the Add Equipment task. 

 
Exhibit 82. Suspend Work 

 

• Write a description that makes it easy to locate the suspended task to resume work. 
For example, “Add Equipment” might mean one of several add tasks, so the 
Equipment ID would be helpful. 

• Select OK to suspend the task. 
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b. If no errors are found, a successful validation message is displayed under the page title. 
Continue with the next step. 

11. Select Submit. The Equipment updates submitted to the system - Success page is displayed 
(Exhibit 83). 

Exhibit 83. Equipment updates submitted to the system - Success 

 

12. Select OK to exit, or select another Umler application menu item (refer to Exhibit 4). 
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Clone Equipment 
The Clone Equipment function is used to add single and multiple equipment by cloning from an 
existing unit. 

1. Select Maintenance>Add/Change/Delete>Clone Equipment. The Clone Equipment page is 
displayed (Exhibit 84). 

Exhibit 84. Clone Equipment 

 

2. Type a source equipment ID: 

Note: Cloned equipment source can be from any owner/road. 
 

a. Choose a known “matching” Equipment ID from user’s road rolling stock or a known 
other road’s similar equipment. 

b. Perform a search for a unit with the same characteristics. See Equipment Query on page 
18. Check the Equipment ID search result, open the drop-down at the right, highlight 
Clone Equipment and select OK to open the Clone Equipment page with the selected 
record as the source for cloning. 

3. Type the new Equipment IDs to be created from the source. See the Note on page 58. 

4.  (Optional) Select Validate to have Umler validate the request. Otherwise continue. 

5. Select Submit. The system checks to make sure the Source ID and New Equipment IDs 
entered are not already in Umler (active or inactive). 

a. If an active ID exists, the cloning is not allowed. An error message is displayed. 

b. If an inactive ID is found, an information message suggests using Add-Back to reactivate 
the ID. See Add-Back Equipment on page 64. 

c. If the requested IDs are valid, the Clone Equipment element entry page is displayed 
(Exhibit 85). 
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Exhibit 85. Clone Equipment (pre-populated with source entries) 

 

Elements shown in the table are based upon the Equipment Type selection made. Mandatory 
elements have the red dot in the Flag field ( ). See Exhibit 6 for other flag icons. 

This page has navigation and display characteristics similar to that described in Display Unit on 
page 14. 

Warning: Certain mandatory fields do NOT port over to the cloned records. New inputs are 
required. 

 
6. Complete the fields in the entry page table: 

a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help on page 182. 

c. Ensure all mandatory fields have been completed. 

7. When all input is done, select Validate. The system validates entries against railroad business 
rules and acceptable values and displays an error message under the page title and displays 
any element-specific error message in the error column beside the element. 

8. Correct errors and revalidate as described in Step 9 on page 60. 

9. (Optional) Suspend the clone task for later completion as described in the Note on page 60. 

10. Select Submit to clone the new equipment units. The Equipment updates submitted to the 
system Success page is displayed (similar to Exhibit 83). 
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Add-Back Equipment 
The Add-Back Equipment function is used to reactivate “archived” single and multiple equipment 
units one at a time. If you want to add-back a range of multiple units at once, use the Add-Back 
Multiple Equipment function. 

1. Select Maintenance>Add/Change/Delete>Add-Back Equipment. The Add-Back 
Equipment page is displayed (Exhibit 86). 

Exhibit 86. Add-Back Equipment 

 
2. Type in at least one of the five input fields to search in deletion history. Optionally restrict the 

search with a date range for the deletion period. Refer to Exhibit 20 and Exhibit 23 for field 
descriptions. 

3. Select Search. Matching records are displayed on the Add-Back Equipment page (Exhibit 
87). 

Exhibit 87. Add-Back Equipment (Search Results) 

 

4. Select the Equipment ID link to further process the record. The Add-Back Equipment page 
entry table is displayed (similar to Exhibit 83). 

Elements shown in the table are based upon the Equipment Type of the old equipment. 
Mandatory elements have the red dot in the Flag field ( ). See Exhibit 6 for other flag icons. 
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This page has navigation and display characteristics similar to that described in Display Unit 
on page 14. 

Warning: Certain mandatory fields (notably Owner) do NOT carry over to the Add-Back 
records. New inputs are required. 

 
5. Complete the fields in the entry page table: 

a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help on page 182. 

c. Ensure all mandatory fields have been completed. 

6. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values. If errors are found,  an error message appears under the 
page title and any element-specific error messages are displayed in the error column beside 
the element. 

7. Correct errors and revalidate as described in Step 9 on page 60. 

8. (Optional) Suspend the Add-Back task for later completion as described in the Note on 
page 60. 

9. Select Submit to Add-Back the equipment units. The Equipment updates submitted to the 
system Success page is displayed (similar to Exhibit 83). 
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Add-Back Multiple Equipment 
The Multiple Equipment Add-Back function is used to reactivate multiple “archived” equipment 
units at one time. 

Note: If equipment has been added and deleted several times then the Add-Back Multiple 
Equipment function cannot be used. Instead, the equipment must be added one at a 
time via the regular Add-Back Equipment function. 

 

1. Select Maintenance>Add/Change/Delete>Multiple Add-Back. The Multiple Equipment 
Add-Back page is displayed (Exhibit 88). 

Exhibit 88. Multiple Equipment Add-Back 

 

2. Type in at least one of the five input fields to search in deletion history. Optionally restrict the 
search with a date range for the deletion period. Refer to Exhibit 20 and Exhibit 23 for field 
descriptions. 

3. Select Search. Matching records are displayed on the Multiple Equipment Add-Back page 
(Exhibit 89). 
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Exhibit 89. Multiple Equipment Add-Back (Search Results) 

 

4. Select one or more of the listed equipment IDs. 

5. Select Submit to Add-Back the equipment units. The Equipment updates submitted to the 
system Success page is displayed (similar to Exhibit 83). 
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Modify Single Equipment 
The Modify Single Equipment function is used to change a single equipment unit. 

Note: Equipment units that are in “conflict” require solution of all conflicts when making 
changes. Making changes to one element can cause conflicts in another related element. 
Read through all of the errors, as they can be related to a single input field. Unresolved 
conflicts can result in Umler enforcing AAR business rules against the equipment. Refer 
to the Umler Data Specification Manual for acceptable values for fields and assistance in 
resolving conflicts, as well as descriptions of conflict-related business rules.  

 
1. Select Maintenance>Add/Change/Delete>Modify Single Equipment. The Modify Single 

Equipment page is displayed (Exhibit 90). 

Exhibit 90. Single Equipment Modify 

 

2. Type the Equipment ID of the equipment to be modified. 

Note: If Modify was selected from a query result, Single Equipment Modify - Components 
by Element View page is displayed (Exhibit 91). 

 
3. (Optional) Select the View Components by Location radio button. Component and Location 

diagrams and descriptions are provided in the Umler Data Specification Manual (accessed 
from the upper right Help link). 

4. Select Modify. The Single Equipment Modify - Components by Element View page is 
displayed (Exhibit 91). 
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Exhibit 91. Single Equipment Modify - Components by Element View 

 

5. Select or type values in the fields that require changing. 

Note: For element field help, select the ID link for the field. See Field Help on page 182. 
 

If viewing components in location view, or if the Switch View button is selected, some 
additional fields are available (Exhibit 92). 

Exhibit 92. Single Equipment Modify - Components By Location View 
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In Exhibit 92, the Truck System shows one component in the box at the right, and existing values 
are shown in the four fields under Location_F. 

a. To add another Truck, increment the 1 in the box to 2, and select Go. A new Location 
with open fields is provided (Exhibit 93). 

Exhibit 93. After Adding Second Truck Component 

 

It is LOCATION_A and has the same elements as LOCATION _F, but no values. 

b. Add the new values as appropriate. 

6. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values. If errors are found,  an error message appears under the 
page title and any element-specific error messages are displayed in the error column beside 
the element. 

7. Correct errors and revalidate as described in Step 9 on page 60. 

8. (Optional) Suspend the modify task for later completion as described in the Note on page 60. 

9. Select Submit to modify equipment unit. The Equipment updates submitted to the system 
Success page is displayed (similar to Exhibit 83). 

Modify Multiple Equipment 
 The Modify Multiple Equipment function is used to change records for multiple equipment units in 
a single edit session. 

Note: Equipment units that are in “conflict” require solution of all conflicts when making 
changes. Making changes to one element can cause conflicts in another related element. 
Read through all of the errors, as they can be related to a single input field. Refer to the 
Umler Data Specification Manual for acceptable values for fields and assistance in 
resolving conflicts. Refer to the Note on page 68. 

 
1. Select Maintenance>Add/Change/Delete>Modify Multiple Equipment. The Modify 

Multiple Equipment Units page is displayed (Exhibit 94). 
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Exhibit 94. Modify Multiple Equipment Units 

 

2. Type the Equipment IDs to be modified. 

Note: Equipment IDs may already be populated if this page was accessed with selections 
from a query (Exhibit 30). 

 
3. Select Submit. The Modify Multiple Equipment Units (select elements) page is displayed 

(Exhibit 95). 

Exhibit 95. Modify Multiple Equipment Units (select elements for update) 

 

4. Highlight the elements to be modified in the Available Elements window (hold Ctrl key to 
make multiple selections). 

5. Select the right arrow ( ) to move the elements to the right Selected Elements window. In 
Exhibit 95, three elements are selected. To remove elements, highlight the unwanted element 
in the right Selected Elements window and select the left arrow ( ). Use the up & down 
arrows at the right to change the order in which the selected elements are to be displayed. 

6. Select Submit. The Modify Multiple Equipment Units page is redisplayed with chosen 
elements, existing values, and an input field for the new value (Exhibit 96). 
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Exhibit 96. Modify Multiple Equipment Units (three elements—current & new fields shown) 

 

7. Type in values for the elements to be changed for each equipment. 

a. To return to the previous page to select other elements, select Element Selection. 

b. Use the copy icon ( ) to copy a new typed value into all fields for that element column. 

8. Select Submit. The system automatically validates the new entries against business rules and 
errors are displayed above the requested changes by Equipment ID. Resolve errors as 
described in Step 9 on page 60. 

Note: If validation fails after several attempts at correction and revalidation, select Suspend 
to save the work until error corrections can be clearly identified. The Suspend Work 
page is displayed (Exhibit 82). See Suspended Work on page 127 to resume the 
Modify Equipment task. 

 
9. When all conflicts or errors have been corrected, select Submit again. 

Exhibit 97. Equipment Updates Submitted to the System 

 

10. Select OK to return to the Welcome page. 
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Single Restencil 
Note: When a car is restenciled (generally for a change in ownership), the losing road must 

grant View Confidential Data Rights for the Umler record to the gaining road, and the 
gaining road must accept the rights, and assign to a user (or put into a profile for multiple 
users) before it can perform the Umler restencil task. See Grant Access Rights on page 
158. Only active or inactive equipment can be restenciled (cannot be in pre-registered 
status). When equipment that is restenciled is made active, open EHMS alerts are copied 
to the new equipment record. 

 
To restencil an equipment: 

1. Select Maintenance>Add/Change/Delete>Single Restencil. The Restencil Equipment page 
is displayed (Exhibit 98). 

Exhibit 98. Restencil Equipment 

 

2. Type in the Source Equipment ID (old ID). 

3. Type the Target Equipment ID (new ID). 

4. Select radio button for Source and target have identical equipment groups: 

a. If Yes is selected (default), continue with submission. 

b. If No is selected, a drop-down text box is displayed: 

 

Use the drop-down to select the new Equipment Group (refer to Exhibit 80). 

5. Select Submit. The Restencil Equipment page with the record for the new Equipment ID 
displayed (Exhibit 99). 

Note: Many of the existing fields cannot be automatically be transferred to the new record 
(e.g., Maintenance Party, Owner, etc.). 
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Exhibit 99. Restencil Equipment (modify new record) 

 

6. Scroll through the entire record and add values in mandatory fields that did not copy over 
with the record. In the first screen of Exhibit 99, the Owner mandatory field requires a new 
value. Additionally, the Maintenance Party field was changed to reflect the new owner. 

7. When all mandatory fields are input, select Submit. Validation occurs as described in Add 
Equipment on page 58. Resolve errors as described in Step 9 on page 60. 

Note: If validation fails after several attempts at correction and revalidation, select Suspend 
to save the work until error corrections can be clearly identified. The Suspend Work 
page is displayed (Exhibit 82). See Suspended Work on page 127 to resume the 
Modify Equipment task. 

 
If validation succeeds, the Equipment Updates Submitted to the System page is displayed 
(similar to Exhibit 97). It shows the old Equipment ID being made inactive. 

8. Select OK to return to the Welcome page. 



Umler® Maintenance 
Add/Change/Delete | Multiple Restencil 

 

Revised December 2013 75 Umler Version 4.8 

Multiple Restencil 
Note: When a car is restenciled (generally for a change in ownership), the losing road must 

grant View Confidential Data Rights for the Umler record to the gaining road, and the 
gaining road must accept the rights, and assign to a user (or put into a profile for multiple 
users) before it can perform the Umler restencil task. See Grant Access Rights on page 
158. Only active or inactive equipment can be restenciled (cannot be in pre-registered 
status). When equipment that is restenciled is made active, open EHMS alerts are copied 
to the new equipment record. 

 
To restencil multiple equipment units: 

1. Select Maintenance>Add/Change/Delete>Multiple Restencil. The Restencil Multiple 
Equipment page is displayed (Exhibit 100). 

Exhibit 100. Restencil Multiple Equipment 

 

2. Type in the Source Equipment IDs (old IDs). 

3. Type in the Target Equipment IDs (new IDs): 

a. If the No radio button is selected (default), type all Target IDs in the SAME order 
desired. 

b. If the Yes radio button is selected (so numeric gaps present in the Source Equipment IDs 
are preserved with the Target IDs), provide only the starting Target ID. Umler calculates 
the remaining IDs, preserving the gaps. 

4. Select Submit. The Restencil Multiple Equipment page is redisplayed with common 
elements for the type of car (Exhibit 101). 
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Exhibit 101. Restencil Multiple Equipment (common elements for type) 

 
5. In Exhibit 101, The Owner field needed to be changed to CSXT. Optionally, an Effective 

Date of 02-23-2009 was added. 

Note: Other elements might need to be changed as well. The status of restenciled multiple 
cars is Pre-registered, which should be changed as appropriate via Modify, or via 
Query. 

 
6. Select Submit. If validation succeeds, the Equipment Updates Submitted to the System page 

is displayed (similar to Exhibit 97). 

7. Select OK to return to the Multiple Restencil page. 

Change Equipment Group 
STOPPEDThe Change Equipment Group function allows a user to change an Umler Equipment 
Group for a single equipment unit. Examples might be, if a flat car is having a box installed and is 
being rebuilt as a box car, or a V-Flat have an auto rack removed/installed. 

To change an equipment ID’s equipment group: 

1. Select Maintenance>Add/Change/Delete>Change Equipment Group. The Change 
Equipment Group page is displayed (Exhibit 102). 

Exhibit 102. Change Equipment Group 

 
2. Type in the Equipment ID. 

Note: If Change Equipment Group action is selected from a query, this field is populated 
with the selected Equipment ID. 
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3. Select Submit. The Change Equipment Group page is redisplayed with two new fields 
(Exhibit 103). This also occurs if Validate is selected first. 

Exhibit 103. Change Equipment Group (select new Equipment Group) 

 

The existing Equipment Group is shown at the right (FLAT). 

Note: The Target Equipment Group drop-down only contains eligible groups for change. In 
Exhibit 103, boxcar has been selected. 

 
4. Select the new Equipment Group from the drop-down, and select Submit. The Change 

Equipment Group (Modify Equipment task) page is displayed (Exhibit 104). 

Exhibit 104. Change Equipment Group (top of Modify Equipment task) 

 

5. Modify fields as required. Refer to Modify Single Equipment on page 68 for instructions. All 
mandatory fields must be completed. 

6. (optional, but highly recommended) Select Validate. Any errors generated by the Equipment 
Group change will be highlighted in red at the right of the display. Refer to Step 9 on page 60 
for addressing error correction. 

Note: If validation fails after several attempts at correction and revalidation, select Suspend 
to save the work until error corrections can be clearly identified. The Suspend Work 
page is displayed (Exhibit 82). See Suspended Work on page 127 to resume the 
Modify Equipment task. 

 
7. When all errors have been corrected, select Submit. The Equipment updates submitted to the 

system page is displayed (Exhibit 105). 



Umler® Maintenance 
Add/Change/Delete | Change Equipment Group 

 

Revised December 2013 78 Umler Version 4.8 

Exhibit 105. Equipment updates submitted to the system (for Change Equipment Group) 

 

Note: If conflicts or errors exist, a Notice ID link is provided so the user can resolve any 
remaining issues. 

 
8. Select OK to return to the Welcome page. 

9. (Optional) To verify Umler has accepted the equipment group change, query the Equipment 
number (Exhibit 106). 

Exhibit 106. Equipment Query Results (to verify Change Equipment Group) 

 
10.  (Optional) If needed, view the Transaction Log to see a list of all fields actually changed for 

the equipment. See Transaction Log on page 42. 
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Update Equipment Maintenance Party 
This function allows the user to update the Equipment Maintenance Party which identifies the 
responsible maintenance party for the equipment unit.  This field can be populated with the 
owner, the lessee, or a third party. If the field is blank, the car owner is the default responsible 
maintenance party. 

To update the Maintenance Party for equipment IDs: 

1. Select Maintenance>Add/Change/Delete>Update Equipment Maintenance Party. The 
Update Equipment Maintenance Party page is displayed (Exhibit 107). 

Exhibit 107. Update Equipment Maintenance Party 

 

2. Type in the Equipment ID(s). 

Note: If Update Equipment Maintenance Party action is selected from a query, this field is 
populated with the selected Equipment IDs. 

 
3. Type appropriate mark for the new maintenance party. 

4. Select Submit. The Data Submitted to the System page is displayed (similar to Exhibit 83). 

5. Select OK. The user is returned to the previous page. 

6. (Optional) Verify the maintenance party update by querying the equipment IDs. 

 



Umler® Maintenance 
Add/Change/Delete | Delete Equipment 

 

Revised December 2013 80 Umler Version 4.8 

Delete Equipment 
Note: Equipment is never actually deleted, but the record becomes inactive. Equipment 

deletions can be reversed using the Add-Back Equipment task. See Add-Back Equipment 
on page 64. 

 
The Delete Equipment function allows a user to deactivate an Umler record, sending the record to 
archive. To delete a record: 

1. Select Maintenance>Add/Change/Delete>Delete Equipment. The Delete Equipment page 
is displayed (Exhibit 108). 

Exhibit 108. Delete Equipment 

 

2. Type in the Equipment ID(s). 

Note: If Delete Equipment action is selected from a query, this field is populated with the 
selected Equipment IDs. 

 
3. Select Submit. The Confirm Deletion of equipment page is displayed (Exhibit 109). 

Exhibit 109. Confirm Deletion of equipment 
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4. For each equipment ID listed: 

a. Check the boxes beside the records. 

b. Select an appropriate Delete Reason from the drop-down for the first ID. Valid values are 
shown in Exhibit 110. 

Exhibit 110. Delete Reasons 

 

c. If the reason for the deletions are the same for all equipment IDs listed, select the down 
arrow icon ( ) to the right of the drop-down, to populate the remaining fields with the 
same delete reason. 

5. When all IDs to be deleted have reasons, select Submit. The Delete Confirmation panel is 
displayed to offer one last chance to NOT delete the equipment IDs. 

Exhibit 111. Delete Confirmation panel 

 

6. To delete, select OK. The Delete Equipment Summary page is displayed (Exhibit 112). 

Exhibit 112. Delete Equipment Summary 

 

7. To exit this page, select Done or another Umler menu item. 
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Car Management 
Exhibit 113. Car Management Submenu 

 

Exhibit 114 describes the options on the Car Management submenu. 

Exhibit 114. Car Management Submenu Items and Descriptions 

Menu Item Description 

Create Pool Header Allows a user to create a new Pool header (for a new Pool ID). 

Delete Pool Header Allows a user to delete a Pool header. 

Remove Lessee Allows a user to remove a lessee from Equipment IDs. 

Report Car Grade 
Inspection 

Allows a user to report car grade inspections. 

Update Equipment 
Management Codes 

Allows a user to change selected elements for several equipment units in one 
editing session. 

Update Pool 
Assignments 

Allows a user to update pool assignments for one or multiple pools. 
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Create Pool Header 
Before equipment can be assigned to a pool, a pool header must be established. The pool header 
identifies the pool ID, the type of pool (commodity, agent, shipper, contaminated, or national), a 
descriptive name for the pool, pool location information, and the pool operator(s) if applicable.  
After a Pool Header is established, equipment may be assigned (added) to the pool. To create a 
pool header: 

1. Select Maintenance>Car Management>Create Pool Header. The create Pool Header page 
is displayed (Exhibit 115). 

Exhibit 115. Create Pool Header 

 
2. Complete *mandatory and optional fields. See Exhibit 116. 

Field Descriptions for the top of the page are shown below:  

Exhibit 116. Pool Header Fields 

Field Description 

*Pool ID Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 21 for more information. 

Note: All unassigned equipment uses pool ID = 0000000. 
*Description General description of the pool (20 characters max). 
Extended Description More detailed description of the pool (80 characters max). 
Reporter Assigned alphabetic reporting mark of the carrier reporting for non-

mechanized operators that have made such an agreement with the reporting 
road (4 characters max). 
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Field Description 

*Loading Location The actual shipper loading point or plant location or railroad holding point.  
Must be a valid SPLC location (19 characters max). Use the lookup icon  
( ) to open the Station Look Up page (Exhibit 41). 

*State/Province 
(Loading) 

Indicates the state or province where the pool is located. This is 
automatically populated with Station Lookup results. 

Held-Short Location Actual location where equipment is held-short if not able to be placed at 
the loading location.  Must be a valid SPLC location (19 characters max). 
Use the lookup icon ( ) to open the Station Look Up page (Exhibit 41). 

State/Province 
(Held-Short) 

Indicates the State/Province where the equipment is held-short. This is 
automatically populated with Station Lookup results. 

*Operator 1 Assigned alphabetic reporting mark of the actual operator of a specific pool 
(4 characters max). 

Operators 2, 3 and 4 Four-position Marks indicating the actual operators of a specific pool.  
Used in the case of Joint Pools to indicate the parties participating in the 
pool. 

*Pool Maintenance Code 0 = Not Applicable 
1 = Auto/truck loading multi-level flat cars 
2 = Specially equipped chain tie-down cars 
3 = Equipped with cross bar interior restraining devices 
4 = Automobile parts and bulkhead equipped equipment 
5 = Automobile and truck frame equipment 
6 = Flat cars equipped for saddleback loading 

*Pool Type Used to identify a type of railroad pool assignment: 

C = Equipment assigned to a specific shipper at a specific location 
G = Contaminated cars 
J = Equipment assigned to an agent 
N = Similar to the “C” Pool, except, the equipment is not assigned to a 

specific shipper or loading point (National Pools). 
O = Equipment assigned to Recall pools 
P = Pool comprised of equipment assigned to accommodate a specific 

commodity. 
T = Pool comprised of equipment assigned to an agent.  

 
3. (Optional) Choose the Future radio button to delay the pool addition to a future date. The 

page expands with an On Future Date field. Refer to Step 3 on page 40. 

4. When all fields have been completed, select one of the options described in Exhibit 52. 

When the pool header has been successfully created, it can be populated with equipment using a 
query results action, modifying an Equipment ID, or using Update Pool Assignments on page 92. 
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Delete Pool Header 
This function allows a user to delete a pool header. 

Warning: Only pools without assigned equipment can be deleted. 
 
Note: Deleting a Pool Header can be done from a menu choice, or a car management Pool View 

query results action. 
 
To delete a pool header: 

1. Select Maintenance>Car Management>Delete Pool Header. The Delete Pool Header page 
is displayed (Exhibit 117). 

Exhibit 117. Delete Pool Header 

 

2. Type the Pool IDs to be deleted. 

Note: If the Delete Pool action was selected from a query, the Pool ID(s) field is populated 
with selected Pool IDs. 

 
3. (Optional) Choose the Future radio button to delay the deletion to a future date. The page 

expands with an On Future Date field. Refer to Step 3 on page 40. 

4. Select Submit to delete the pool header or select one of the other processing options (similar 
to Exhibit 52). 
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Remove Lessee 
Remove a Lessee function allows railroads to remove themselves from the lessee field of foreign 
equipment. Removing the lessee can result in the equipment’s removal from its current pool 
assignment (if any). In turn, removal of the equipment from a pool may result in new equipment 
management codes being applied. 

Note: Removing a Lessee can be done from a menu choice, query results action, or while 
modifying an Equipment ID. 

 
To remove a lessee: 

1. Select Maintenance>Car Management>Remove Lessee. The Enter Equipment IDs for 
Lessee Removal page is displayed (Exhibit 118). 

Exhibit 118. Enter Equipment IDs for Lessee Removal 

 

2. Type the Equipment IDs to have Lessee removed. 

Note: If the Remove Lessee action was selected from a query, the Equipment ID(s) field is 
populated with selected Equipment IDs. 

 
3. Select one of the processing options (similar to Exhibit 52). 
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Report Car Grade Inspection 
When the user selects the Maintenance>Car Management>Report Car Grade Inspection, the 
Car Grade Inspection page is displayed (Exhibit 142). This can also be access using the 
Inspection menu item See Car Grade Inspection on page 102 for instructions. 
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Update Equipment Management Codes 
There are five basic types of codes used in the Equipment Management Code structure: user 
defined routing, system generated, pool control, mechanical restriction and mechanical restriction 
reason. This section explains how to determine existing equipment management codes and how to 
update these codes. The system also uses the Legacy UMLER transportation codes and 
transportation condition codes. 

Exhibit 119. Equipment Management Codes 
CODE DESCRIPTION 

MD Mechanical designation 
UR User defined routing (Exhibit 123)  
SG System generated 
PC Pool control 
MR Mechanical restriction (Exhibit 124)  

MRR Mechanical restriction reason (Exhibit 125)  
TC Umler transportation code 

TCC Umler transportation condition code 
 
To change equipment management codes: 

1. Select Maintenance>Car Management>Update Equipment Management Codes. The 
Update Car Management Codes page is displayed (Exhibit 120). 

Exhibit 120. Update Equipment Management Codes 

 

Note: Although entering Equipment IDs and requesting changes can be made directly on this 
page, the user might want to begin from an equipment query, or if existing codes need to 
be viewed first, from a Car Management query (equipment view). Either query allows the 
user to select the Update Equipment Management Codes action for selected Equipment 
IDs. The Car Management Query path is shown is this instruction. 
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2. Select Car Management Query on the Query menu. The Pool/Equipment Search page is 
displayed (Exhibit 39). Execute the query for equipment desired as described in Equipment 
View on page 33. The Pool/Equipment Search Results page is displayed (Exhibit 121). 

Exhibit 121. Pool/Equipment Search Results (with existing codes) 

 
The red box shows the Equipment Management Codes. The UR, MR, and MRR values can be 
modified. 

3. Check the boxes beside the Equipment IDs to be modified exactly the same way. 

4. Select Update Equipment Management Codes in the action drop-down and select OK. The 
Update Equipment Management Codes page is displayed, prepopulated with selected 
Equipment IDs (Exhibit 122). 

Exhibit 122. Update Equipment Management Codes (ready for submission) 
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5. Make updates to the fields: 

a. User Defined Routing Instruction. Valid values include:  

Exhibit 123. User Defined Routing (UR) 

 

b. Mechanical Restriction. Valid values include: 

Exhibit 124. Mechanical Restriction (MR) 

 

c. Mechanical Restriction Reason. Valid values include: 

Exhibit 125. Mechanical Restriction Reason (MRR) 

 

6. When all values are selected, select Submit. The Data Submitted to the System page is 
displayed (similar to Exhibit 83). 

7. If errors are generated, correct and select Submit. 

8. Select OK to exit the page. 

9. (Optional) Verify the Equipment Maintenance Code changes have been updated. If returned 
to the Pool/Equipment Search Results page, select the Search Criteria tab and reselect 
Search. The results page is redisplayed with changes made (Exhibit 126). 
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Exhibit 126. Pool/Equipment Search Results (with updated codes) 

 

The TC and TCC values were automatically updated by MR and MRR updates. 

Note: Only the Railinc Administrator can remove a Mechanical Restriction = S and a 
Mechanical Restriction Reason = X from a piece of equipment. 

 
10. To exit this page, select another Umler menu item. 
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Update Pool Assignments 
The Update Pool Assignment function allows users to add equipment to Pool IDs. 

Note: Updating a Pool Assignment can be done from the menu choice, query results action, or 
while modifying an Equipment ID. 

 
To update pool assignments: 

1. Select Maintenance>Car Management>Update Pool Assignments. The Pool Assignment 
page is displayed (Exhibit 127). 

Exhibit 127. Pool Assignment (from menu) 

 

This page has two sections. The top allows the user to assign multiple equipment IDs into one 
pool. The bottom allows the user to place various individual equipment IDs into respective pools. 
The user must know the pool numbers before beginning. There is no search or lookup function on 
this page—Use a Car Management Query (Pool View) to search. See Pool View on page 38. 

2. Select the appropriate radio button for the assignment desired. Continue with: 

• Assign Equipment to One Pool 

• Assign Equipment to Individual Pools 
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Assign Equipment to One Pool 
3. Type equipment IDs in the Equipment ID(s) field. See Exhibit 21 for acceptable formats for 

entering multiple IDs. 

4. Tab and type the desired single Pool ID. 

5. (Optional) Check Future to delay the assignment, if appropriate. See Exhibit 51. 

6. Select one of the processing options (similar to Exhibit 52). 

Assign Equipment to Individual Pools 
3. Type the first equipment ID in the Equipment ID(s) field. 

4. Tab and type the desired Pool ID for that equipment. 

5. Repeat for each piece of equipment (up to 10 equipment units for this page). 

6. (Optional) Check Future to delay the assignment, if appropriate. See Exhibit 51. 

7. Select one of the processing options (similar to Exhibit 52). 

Adding From a Query 
If Add to Pool action is requested for selected equipment on the Equipment Query Results page, 
the Pool Assignment page is displayed prepopulated with selected Equipment IDs (Exhibit 128). 

Exhibit 128. Pool Assignment (Add Pool action from Query) 

 
1. Tab and type the desired single Pool ID. 

2. (Optional) Check Future to delay the assignment, if appropriate. See Exhibit 51. 

3. Select one of the processing options (similar to Exhibit 52). 
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Removing from a Query 
If Remove from Pool action is requested for selected equipment on the Equipment Query Results 
page, the Confirm Pool Unassignment page is displayed prepopulated with selected Equipment 
IDs (Exhibit 129). 

Exhibit 129. Confirm Pool Unassignment 

 

1.  (Optional) Check Future to delay the unassignment, if appropriate. See Exhibit 51. 

2. Select one of the processing options (similar to Exhibit 52). 
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Inspections 
The Maintenance Inspections function is used to record inspection and service data for 
equipment. 

To record inspections and services: 

1. Select Maintenance>Inspections. The Inspections page is displayed (Exhibit 130). 

Exhibit 130. Inspections 

 
2. Select the link for the inspection or service to be recorded. The corresponding page for that 

inspection is displayed. Because many of the inspection pages are similar, only one 
description is provided for each unique interface, as shown in Exhibit 131. 

Exhibit 131. Inspection/Service Processing 
Inspection/Service Processing Flow Reference 

• AFMC Inspection AMFC Inspection 
• Air Brake Test 
• Autorack Certification 

Air Brake Test 



Umler® Maintenance 
Inspections  

 

Revised December 2013 96 Umler Version 4.8 

• Autorack Repair 
• Door Lube Inspection 
• Reflectorization Event 
• Vehicular Flat Car Certification 
• Autorack Inspection Autorack Inspection 
• Car Grade Inspection Car Grade Inspection 
• Locomotive Air Brake Inspection L1, L2 

and L3 
• Locomotive Air Car Inspection 
• Locomotive Annual Inspection 
• Locomotive Cab Signals Inspection 
• Locomotive Event Recorder Inspection 
• Locomotive Hand Brake Inspection 
• Locomotive Out of Service 
• Locomotive Periodic Inspection 
• Locomotive RCL Inspection 
• QMI Daily Inspection 

Locomotive Air Brake L1 Inspection 

• Locomotive Inspection Due Date Update Locomotive Inspection Due Date Update 
• Locomotive Storage Event Locomotive Storage Event 

 
Note: Selecting equipment, highlighting an inspection action from the query results page drop-

down (Exhibit 30), and selecting OK navigates directly to the corresponding inspection 
pages described in the following sections. 
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AMFC Inspection 
When the user selects the AMFC Inspection link, the AMFC Inspection page is displayed 
(Exhibit 132). 

Exhibit 132. AMFC Inspection 

 

1. Type the *Equipment IDs for which an inspection is to be recorded. 

Note: Equipment IDs may already be populated if this page was accessed with selections 
from a query (Exhibit 30). 

 
2. Complete the required fields (in bold *RED with asterisk): 

Field Description 
*Inspection Reporter Select the 4-character Mark from the drop-down for the person or 

organization reporting the inspection. 
*Inspection Performer Type the 3 to 4-character Mark for the person/shop who performed the 

inspection. 
*Inspection 
Conducted by 

Type the name of person/shop who conducted the inspection. 

*Inspection Certified 
by 

Type the name of person/shop who certified the inspection. 

*Scheduled Due Date Use the calendar picker ( ) to select the date the inspection was scheduled 
to be due. 

*Location SPLC Use the lookup icon ( ) to select the SPLC where the inspection was 
performed (Exhibit 135). 

*Inspection Date Done Use the calendar picker ( ) to select the date the inspection was performed. 
*Inspection Due Date Use the calendar picker ( ) to select the date the inspection was due. 

 

3. When all fields are entered, select one of the options from Exhibit 139: 

Exhibit 133. Air Brake Inspection Processing Options 
Validate Validates data before submission to facilitate error correction.  
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 140 is displayed.  
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Suspend Saves the inspection input for completion later. Opens the Suspend Work page 
(similar to Exhibit 82). See Suspended Work on page 127 to resume the 
inspection task. 

 
4. Select Done to return to the Inspections page (Exhibit 130). 

 

Air Brake Test 
When the user selects the Air Brake Test link, the Air Brake Test page is displayed (Exhibit 
134). 

Exhibit 134. Air Brake Test 

 

Note: Currently, this same interface is used for Autorack Certification, Autorack Repair, Door 
Lube Inspection, Reflectorization Event, and Vehicular Flat Car Certification. Page title 
reflects the appropriate inspection/service. 

 
5. Type the *Equipment IDs for which an inspection is to be recorded. 

Note: Equipment IDs may already be populated if this page was accessed with selections 
from a query (Exhibit 30). 

 
6. Complete the required fields (in bold *RED with asterisk): 

Field Description 
*Inspection Reporter Select the 4-character Mark from the drop-down for the person or 

organization reporting the inspection. 
*Inspection Performer Type the 3 to 4-character Mark for the person/shop who performed the 

inspection. 
*Inspection Date Done Use the calendar picker ( ) to select the date the inspection was performed. 
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Field Description 
*Location SPLC Use the lookup icon ( ) to select the SPLC where the inspection was 

performed (Exhibit 135). 
*Air Brake Test Device Select either A-Automatic or M-Manual.  

 
 

Exhibit 135. SPLC Lookup 

 
a. Enter criteria for Lookup and select Search. The SPLC Lookup Results page is displayed 

(Exhibit 136). 

Exhibit 136. SPLC Lookup Results 

 
b. Select the radio button beside the correct location and select OK. The results are used to 

populate the Location field. First row entry might appear as shown in Exhibit 137. 

Exhibit 137. Air Brake Test (with one entry) 
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7. (As needed for same entry values) Use the down arrow icon ( ) to repeat the entry for all 
successive fields. In Exhibit 138, two columns were repeated using the down arrow icon. 

Exhibit 138. Air Brake Test (with 3 columns repeated) 

 
8. When all fields are entered, select one of the options from Exhibit 139: 

Exhibit 139. Air Brake Inspection Processing Options 
Validate Validates data before submission to facilitate error correction.  
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 140 is displayed.  
Suspend Saves the inspection input for completion later. Opens the Suspend Work page 

(similar to Exhibit 82). See Suspended Work on page 127 to resume the 
inspection task. 

 
Exhibit 140. Air Brake Test (results submitted) 

 

9. Select Done to return to the Inspections page (Exhibit 130). 
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Autorack Inspection 
When the user selects the Autorack Inspection link, the Autorack Inspection page is displayed 
(Exhibit 141). 

Exhibit 141. Autorack Inspection 

 

1. Complete the first five fields as described in Steps 5 and 6, beginning on page 98. 

2. Type the autorack inspector’s ID. 

3. Complete the remaining nine fields using the drop-down to select the appropriate rating. 

4. When all fields are entered, select one of the options from Exhibit 139. 
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Car Grade Inspection 
When the user selects the Car Grade Inspection link, the Car Grade Inspection page is displayed 
(Exhibit 142). 

Exhibit 142. Car Grade Inspection 

 

1. Type the 3- to 4-character Inspecting Mark (or use drop-down to select from those roads the 
logged on user is authorized to represent). 

2. For each graded equipment (10 max this page): 

a. Type the equipment ID for which a car grade inspection is to be recorded. This can be 
automatically populated as described in Step 5 on page 98. Only one Equipment ID per 
field. The page expands beyond ten fields if automatically populated. 

b. Select the car grade specified by the Inspector from the drop-down. 

Note: For more information about car grades, see the current Field Manual of the 
A.A.R. Interchange Rules, which can be obtained from TTCI at 719-584-0750 
(ask for Publications). 

 
c. Use the calendar picker ( ) to select the date the car grade inspection was performed. 

d. Type a 2-digit hour (01–12), and minutes (00–59), and select the AM or PM radio button 
in the Time field. 

e. Location SPLC—Use the lookup icon ( ) to select the SPLC where the car grade 
inspection was performed (refer to Exhibit 135). 

3. When all fields are entered, select one of the options from Exhibit 139. 
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Locomotive Air Brake L1 Inspection 
When the user selects the Locomotive Air Brake L1 Inspection link, the Locomotive Air Brake 
L1 Inspection page is displayed (Exhibit 143).  

Exhibit 143. Locomotive Air Brake L1 Inspection 

 

Note: Currently, this same interface is used for Locomotive Air Brake (L1, L2 and L3) 
Inspection, Locomotive Annual Inspection, Locomotive Cab Signals Inspection, 
Locomotive Quarterly Inspection, and Locomotive RCL Inspection. Page title reflects the 
appropriate inspection/service. 

 
1. Complete the first five fields as described in Steps 5 and 6, beginning on page 98. 

2. Use the calendar picker ( ) to select the date the next locomotive inspection is scheduled. 

3. (As needed for same entries) Use the down arrow icon ( ) to repeat the entry for all 
successive fields. 

4. When all fields are entered, select one of the options from Exhibit 139. 
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Locomotive Inspection Due Date Update 
Note: A user must be authorized to update a locomotive inspection due date. See Add 

Inspection Right on page 146. 
 
When the user selects the Locomotive Inspection Due Date Update link, the Update Locomotive 
Inspection Due Dates page is displayed (Exhibit 144). 

Exhibit 144. Update Locomotive Inspection Due Dates 

 

Four different inspection type updates can be submitted. 

1. Type the equipment IDs for which a specific update is needed. 

Note: Equipment IDs may already be populated if this page was accessed with selections 
from a query (Exhibit 30). 

 
2. Use the drop-down to select the locomotive inspection to be updated. Exhibit 144 shows one 

drop-down opened. 

3. Use the calendar picker ( ) to select the date the next Scheduled and Inspection Due Dates. 

4. When all fields are entered, select one of the options from Exhibit 139. 
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Locomotive Storage Event 
Note: A user must be authorized to update a locomotive inspection due date. See Add 

Inspection Right on page 146. 
 
An FRA Drop Dead Date is the date a locomotive would not be allowed to be on the road due to 
an expired inspection date. Locomotives not needed for moving trains are sometimes removed 
from the road for a period of non-use. When a locomotive is in storage, its FRA Drop Dead Date 
is extended for the period of storage (or to a specified new FRA Drop Dead Date). 

When the user selects the Locomotive Storage Event link, the Report Locomotive Storage Event 
page is displayed (Exhibit 145). 
Exhibit 145. Report Locomotive Storage Event 

 

1. Type the equipment IDs for which a storage event is to be reported. Refer to the Equipment 
ID(s) description on page 19. 

Note: Equipment IDs may already be populated if this page was accessed with selections 
from a query (Exhibit 30). 

 
2. Select the appropriate radio button: 

• Number of days in storage 
• New FRA Drop Dead Date 

3. Enter Storage Data: 

• For Number of days in storage, type a numeric entry  (e.g., 90). 
• Use the calendar picker ( ) to select the New FRA Drop Dead Date. 

4. When all fields are entered, select one of the options from Exhibit 139. 
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Company-Specific Equipment Groups 
Company-Specific Equipment groups are private pools of equipment that are only available to the 
company specified. Umler allows you to assign and remove equipment from company-specific 
equipment groups. 

Exhibit 146. Company-Specific Equipment Groups Submenu 

 

Exhibit 147 describes the options on the Company-Specific Equipment Groups submenu. 

Exhibit 147. Company-Specific Equipment Groups Items and Descriptions 

Menu Item Description 

Search Group Allows a user to search for and view Company-Specific Equipment groups.  

Create Group Allows a user to create a new Company-Specific Equipment group. 

Add Equipment to 
Group 

Allows a user to add equipment to a Company-Specific Equipment group.  

Remove Equipment 
from Group 

Allows a user to remove equipment from a Company-Specific Equipment 
group. 

Move Equipment 
Between Groups 

Allows a user to move equipment between Company-Specific Equipment 
groups.   
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Search Group 
The Search Group function allows users to search for company-specific equipment groups based 
on company-specific equipment group attributes, equipment attributes, and/or equipment 
ownership/control attributes. 

Note: The system displays only those company-specific equipment groups created by the user’s 
company. 

 
1. Select Maintenance>Company-Specific Equipment Groups>Search Group. The Search 

for Company-Specific Equipment Groups (Basic) page is displayed (Exhibit 148). 

Exhibit 148. Search for Company-Specific Equipment Groups (Basic) 

 

2. Complete search criteria as needed. Refer to Exhibit 149 for field descriptions. *Red fields 
are mandatory. 
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Exhibit 149. Company-Specific Equipment Groups Field Descriptions 

Field Description 

*View Select group view or equipment view. 
• In Group View, if the user enters no search criteria, Umler displays 

all company-specific equipment groups created by the user’s 
company. Best choice for deleting or editing a group. 

• In Equipment View, the user must specify at least one search 
parameter. 

Group ID(s) Identification number assigned to an equipment group (alphanumeric, with 
no spaces). Must be unique. 

Group Name Name given to an equipment group. 
Group Description Description given to an equipment group. 
Equipment ID(s) Type the specific equipment IDs (e.g., abcd123) or search with a range 

(e.g., abcd123-999) or a wildcard. See Exhibit 21 for more information. 
Equipment Type Codes Type the complete code (e.g., M500) in the single blank input field. 
Equipment Group(s) Used to indicate the general equipment group being sought. Multiple-

selection text box. See Equipment Group(s) in Exhibit 20. 
Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
Umler Data Specification Manual. 

Creator User ID System User ID used when Group was created. 
Last Updated User ID System User ID used when Group was last updated. 
Equipment Initials The initials stenciled on the specified equipment. 
Umler Owner The Umler owners of the specified equipment. 
EMIS Company The EMIS company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Mark Owner The stenciled mark owners for the specified equipment. 

 
3. (Optional) Select the Group Fields tab. The Search for Company-Specific Equipment 

Groups (Group Fields) page is displayed (Exhibit 150). 

a. Each field can contain up to 80 characters. 

b. Typical use might include specific commodities for the group (e.g., Paper Rolls for a 
certain group of boxcars). Searches can be done using these special fields; however, 
matches must be exact, including the field letter (i.e., something entered in field A must 
be searched for in field A). 



Umler® Maintenance 
Company-Specific Equipment Groups  | Search Group 

 

Revised December 2013 109 Umler Version 4.8 

Exhibit 150. Search for Company-Specific Equipment Groups (Group Fields) 

 

4. Use the *Output to: drop-down menu to have the search results displayed to the browser 
(default), or select CSV to save a file of the output. See Warning on page 18. 

5. Use the *Maximum Number of Results: (Browser Output Only) drop-down to select the 
maximum number of result records to be returned (100, 500, 1000—default is 1000). 

6. Select a processing option: 

Exhibit 151. Search for Company-Specific Equipment Groups Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. The 

Company-Specific Equipment Group Search Results screen is displayed  
(Exhibit 152 for Group View or Exhibit 158 for equipment view). 

Count Executes the search and outputs a single line message with the count of records 
meeting the specified criteria. Similar to Exhibit 36. 
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Exhibit 152. Company-Specific Equipment Groups Search Results (Group View) 

 

7. Select the check boxes beside the Equipment Group IDs to be processed. 

8. Choose from the following options: 

a. Deleting a Group 

b. Viewing/Editing a Group 

c. Viewing Creator or Last Updated User IDs 

d. Select the Search Criteria tab to do another search. 

Deleting a Group 
To delete a group, select the check box beside the group ID and select OK in the action drop-
down. The Confirm Delete of Company-Specific Equipment Group(s) page is displayed (Exhibit 
153). 

Exhibit 153. Confirm Delete of Company-Specific Equipment Group(s) 

 

To confirm the delete, select Submit. A data submission page is displayed (not shown). Select 
OK. The Company-Specific Equipment Groups link page is displayed (Exhibit 154). 

Exhibit 154. Company-Specific Equipment Groups link 

 

Select links as appropriate, or select another application menu item. 
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Viewing/Editing a Group 
While on the Company-Specific Equipment Groups Search Results (Group View) page (Exhibit 
152), select the Group ID link. The View Company-Specific Equipment Group page is displayed 
(Exhibit 155). 
Exhibit 155. View Company-Specific Equipment Group 

 
When finished viewing, select Done to return to the search results. 

• To view User contact information, select the User ID links and refer to Viewing Creator 
or Last Updated User IDs. 

• To edit the Group, select Edit. The Edit Company-Specific Equipment Group page is 
displayed (Exhibit 156). 

Exhibit 156. Edit Company-Specific Equipment Group 

 
Edit fields as required and select Submit. A data submission page is displayed (not shown). 
Select OK. The Company-Specific Equipment Groups link page is displayed (Exhibit 154). 
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Viewing Creator or Last Updated User IDs 
When a User ID link is selected on a page, the User Contact Info page for that person is displayed 
(Exhibit 157). 

Exhibit 157. User Contact Info 

 

To send the person an e-mail, select the e-mail link. Otherwise, select Done to return to previous 
page. 

Exhibit 158. Company-Specific Equipment Groups Search Results (Equipment View) 

 

Select the check boxes beside the Equipment IDs to be processed, choose either the Add or 
Remove action drop-down option, and select OK. Refer to: 

• Add Equipment to Group on page 114 or 

• Remove Equipment from Group on page 117. 
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Create Group 
To create a new Company-Specific Equipment Group: 

1. Select Maintenance>Company-Specific Equipment Groups>Create Group. The Create 
Company-Specific Equipment Group page is displayed (Exhibit 159). 

Exhibit 159. Create Company-Specific Equipment Group 

 

2. Enter the two required fields (refer to Exhibit 149). 

3. (Optional) Enter Group fields as described in Step 3 on page 108. 

4. Select Submit to create the group. A data submission page is displayed (not shown). Select 
OK. The Company-Specific Equipment Groups link page is displayed (Exhibit 154). 

Note: No equipment is in the new group. Choose the Add Equipment to Company-Specific 
Equipment Group link and refer to Add Equipment to Group on page 114. 
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Add Equipment to Group 
Note: Equipment cannot be added to a group from a regular Equipment Query. The query must 

be from Company-Specific Equipment Groups Search Results (Equipment View) page 
(Exhibit 158). 

 
To add equipment to a Company-Specific Equipment Group: 

1. Select Maintenance>Company-Specific Equipment Groups>Add Equipment to Group. 
The Add Equipment to Company-Specific Equipment Groups page is displayed  
(Exhibit 160). 

Note: Up to four Group ID equipment additions can be processed at one time on this page. 
 

Exhibit 160. Add Equipment to Company-Specific Equipment Groups 

 

2. Type the Equipment ID(s) in the field. 

Note: If coming from a Group search results equipment view, the Equipment ID(s) field is 
populated with selected Equipment IDs.  

 
3. Type in the known Group ID, or use the lookup icon ( ) to search for a Group ID. The 

Company-Specific Equipment Group Lookup page is displayed (Exhibit 161). 
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Exhibit 161. Company-Specific Equipment Group Lookup 

 

a. Enter criteria to locate the appropriate Group. Refer to Exhibit 149 for field descriptions. 

Note: Group fields are not available on the lookup page. 
 

b. Select Search. The Company-Specific Equipment Group Lookup Search Results page is 
displayed. 

Exhibit 162. Company-Specific Equipment Group Lookup Search Results 

 

c. Select the radio button beside the group desired and select OK. The Add Equipment to 
Company-Specific Equipment Groups page is redisplayed with the selected group 
(Exhibit 163). 
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Exhibit 163. Add Equipment to Company-Specific Equipment Groups (completed) 

 

4. Select Submit to add the equipment. A data submission page is displayed (not shown). Select 
OK. The Company-Specific Equipment Groups link page is displayed (Exhibit 154). 
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Remove Equipment from Group 
Note: Equipment cannot be removed from a group from a regular Equipment Query. The query 

must be from Company-Specific Equipment Groups Search Results (Equipment View) 
page (Exhibit 158). 

 
To remove equipment from a Company-Specific Equipment Group: 

1. Select Maintenance>Company-Specific Equipment Groups>Remove Equipment from 
Group. The Remove Equipment from Company-Specific Equipment Groups page is 
displayed (Exhibit 164). 

Exhibit 164. Remove Equipment from Company-Specific Equipment Groups 

 

2. Type the Equipment ID(s) in the field. 

Note: If coming from a Group search results (equipment view), the Equipment IDs are 
shown in the Confirm Removal of Equipment from Company-Specific Equipment 
Groups page is displayed (Exhibit 165). 

 
3. Select Next. The Confirm Removal of Equipment from Company-Specific Equipment 

Groups page is displayed (Exhibit 165). 

Exhibit 165. Confirm Removal of Equipment from Company-Specific Equipment Groups 

 

4. Select the check box beside each Equipment ID to be removed. 

5. Select Submit. A data submission page is displayed (not shown). Select OK. The Company-
Specific Equipment Groups link page is displayed (Exhibit 154). 
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Move Equipment Between Groups 
To move equipment from one Company-Specific Equipment Group to another: 

1. Select Maintenance>Company-Specific Equipment Groups>Move Equipment between 
Groups. The Move Equipment to Another Company-Specific Equipment Group page is 
displayed (Exhibit 166). 

Exhibit 166. Move Equipment to Another Company-Specific Equipment Group 

 

2. Type in the Equipment IDs to be moved. 

Hint: Because the move option is NOT available in the action drop-down in the Equipment 
view search results, the user can choose to “Add” selected IDs and view the entire set of 
IDs in the Add Equipment to Company-Specific Equipment Groups page (Exhibit 160). 
The Equipment IDs field can be copied by placing the cursor in the box and pressing 
Ctrl+A to select them all and pressing Ctrl+C to copy all. Then without executing any 
Add function, choose the Move Equipment between Groups menu item, and paste 
(Ctrl+V) the copied Equipment IDs into the Equipment ID field on the Move page. 

 
3. Type in the current Group ID, or use the lookup icon ( ) to search for a Group ID. Refer to 

Step 3 on page 114 for instructions. 

4. Type in the new Group ID, or use the lookup icon ( ) to search for a Group ID. Refer to 
Step 3 on page 114 for instructions. 

5. Select Submit. A data submission page is displayed (not shown). Select OK. The Company-
Specific Equipment Groups link page is displayed (Exhibit 154). 
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Notice Management 
The Notice Management function allows the user to process  informational, warning, and error 
notices via the Umler web interface.  Each company’s administrator defines how the Umler 
should inform the user’s company (e.g. tickler preferences).  Regardless of those preferences, the 
user can manage the notices within Umler.  Umler allows the user to search for notices based on 
detailed search criteria, view notice details, fix errors related to notices, and suppress read, 
resolved, or unwanted notices. 

To manage notices: 

1. Select Maintenance>Notice Management. The Search Notices page is displayed  
(Exhibit 167). 

Exhibit 167. Search Notices (top–mandatory fields) 

 

2. Enter search criteria as desired. Red fields are mandatory. Field Descriptions for the top of 
the page are shown in Exhibit 168. 

Exhibit 168. Search Notices Field Descriptions (top) 

Field Description 

*Starting Date/Time Use the calendar picker ( ) to select the dates to be queried. 

Note: Default Date/Time is two days starting at midnight the previous 
day and ending today at 11:59 PM. 

Type a 2-digit hour (01–12), and minutes (00–59), and select the AM or 
PM radio button in the Time field. 
 
Note: Select the Search All Dates check box in order to search all dates. 

Equipment ID(s)  Type the specific equipment IDs (e.g., abcd123) or search with a range 
(e.g., abcd123-999) or a wildcard. See Exhibit 21 for more information. 

Company-Specific 
Equipment Group(s) 

Type in the current Group ID, or use the lookup icon ( ) to search for a 
Group ID. Refer to Step 3 on page 114 for instructions. 
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Field Description 

*Notice Type Select the Notice Type. Multiple selections are allowed. The default is 
ALL. 

*Notice Level Select the Notice Level of Error, Information, and Warning. Multiple 
selection is allowed. The default is ALL. 

• Error—notices which have failed to pass business rules. Because of 
these errors, the related transactions have failed to update the Umler 
database.  The system creates an error notice when the user submits a 
pool or equipment transaction that violates the business or security 
rules. 

• Information—notices which inform user of system processes.  For 
example, an information notice is created to inform user of the 
completion of a bulk upload.  The system creates informational notices 
for company-specific events. 

• Warning—The system creates a warning notice to warn about 
company-specific events. For example, the system will warn a 
company prior to deleting one of its idle pool headers. 

*Notice Status Select the Notice Status of Active (default), Deleted, or Both. 

Note: Notices are not deleted, rather their status is just changed to 
“deleted”. When the issue mentioned in the notice has been 
successfully resolved the status changes to “deleted”. 

*Notice Group Select the Notice Group of Normal (default), Future Effective, or Conflict. 

Note: Unresolved conflicts can result in Umler enforcing AAR business 
rules against the equipment. Refer to the Umler Data Specification 
Manual for information about these rules and conflict resolution. 
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Exhibit 169. Search Notices (bottom–optional fields) 

 

3. (Optional) Enter search criteria as desired. Field Descriptions for the bottom of the page are 
shown in Exhibit 170. 

Exhibit 170. Search Notices Field Descriptions (bottom) 

Field Description 

Event Response 
Code(s) 

Type in a known Event Response Code or use the lookup icon ( ) to 
search for a code. The Notice Error Codes Lookup page is displayed. 

Note: Use a find (Ctrl+F) within the lookup page to locate the needed 
error. 

Exhibit 171. Notice Error Codes Lookup 

 
Check the boxes beside the appropriate descriptions and select OK. The 
Search Notices page is redisplayed with the selected codes. 

Equipment Type Code Alphanumeric code (one alpha and three numeric) used to designate a 
specific type of equipment and attributes. 
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Field Description 

Equipment Group Used to indicate the general equipment group being sought. See Equipment 
Group(s) in Exhibit 20. 

Pool ID Search for notices related to the specified pool ID(s). 
Mechanical Designation Search for notices related to equipment with the specified mechanical 

designation(s). 
Notice ID Search for notices with specific notice ID(s). This can be from online 

notices, or e-mails. 
User ID Search for notices related to actions taken by a specified user ID(s). 
Element ID(s) Type in a known Element ID or use the lookup icon ( ) to search for an 

ID. The Element ID Lookup page is displayed. 

Note: Use a find (Ctrl+F) within the lookup page to locate the needed 
element. 

Exhibit 172. Element ID Lookup (using Find) 

 
Check the boxes beside the needed element IDs and select OK. The Search 
Notices page is redisplayed with the selected IDs. 

Restrict results to only 
Element ID(s) 

Use this check box to restrict the results to only Element IDs. 

Equipment Initials The initials stenciled on the specified equipment. 
Umler Owner The Umler owners of the specified equipment. 
EMIS Company The EMIS Company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Owner Mark The stenciled mark owners for the specified equipment. 

 
4. Set the *Output to: drop-down to browser to have the search results displayed in the browser 

(default). Otherwise, select CSV.  

5. (For browser only) Set the *Maximum Number of Results: field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

6. Select one of the processing options shown in Exhibit 173. 
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Exhibit 173. Search Notices Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See Online 

Notice Search Results on page 123 or CSV Notice Search Results on page 125. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria. See Exhibit 36. 
 

Online Notice Search Results 
If the user has chosen to view search results online, the Notice Search Results page is displayed 
(Exhibit 174). 

Exhibit 174. Online Notice Search Results 

 

Options on this page include: 

View Notice Details—Select the Notice ID link. See Exhibit 175. 

View User Information—Select the User ID link. See Exhibit 157. 

And from the Action Drop-Down: 

Delete Selected—Check the boxes beside Active notices to be deleted (Status set to inactive), set 
the drop-down to Delete (default), and select OK. Delete can also be done while viewing notice 
details (see Exhibit 175 and Exhibit 176). 

Restore Selected—Check the boxes beside Deleted notices to be restored (Status set to active), 
set the drop-down to Restore, and select OK. Restore can also be done while viewing notice 
details (see Exhibit 175 and Exhibit 176). 

Note: When notices are deleted or restored, the page does not reflect those changes unless 
refreshed (by executing the search again). To search again, select the Search Criteria tab 
and select Search. 
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View Notice Details 
When the user select the Notice ID link on the Notice Search Results page (Exhibit 174), the 
Notice Details page is displayed (Exhibit 175). 

Exhibit 175. Notice Details (Active Error) 

 
In this notice, the new data entered did not meet business rules (reason written in red at right). 
The pool number is from CSXT (begins with 712), but the Pool Operator 1 is entered as BNSF. 
Either the Pool ID is incorrect or the Pool Operator 1. 

If the user is authorized, and corrections are known, the corrected input can be entered directly on 
this page in the new data column, validated and submitted. 

To view User ID information, select the user ID link. See Exhibit 157. 

Note: Use the Previous | Next links at the upper right to view details of the previous or next 
notice from the Notice Search Results list. 

 
Processing options include: 

Exhibit 176. Notice Processing Options 
Validate Validates data before submission to facilitate error correction. Fixing one error can 

produce another when business rules are applied. 
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 140 is displayed.  
Delete 
    or 
Restore 

Toggles the status of the notice. If the notice is active, only the Delete button 
appears. If the status is deleted, only the Restore button appears.  

Done Returns to the Search Results page (Exhibit 174). 
 



Umler® Maintenance 
Notice Management  

 

Revised December 2013 125 Umler Version 4.8 

CSV Notice Search Results 
If the user has chosen to view/save CSV search results, the search results are displayed in MS 
Excel (Exhibit 177). 

Exhibit 177. CSV Notice Search Results (in Excel) 

 

If the user chose to “Open” the file rather than “Save” it (refer to Exhibit 33),  it can be saved as 
an Excel file while viewing. 

Exhibit 178 contains information for reading CSV notice records.  

• The information for each notice spans multiple lines. 

• A notice always begins with a summary line. 

• The summary line is followed by zero or more element lines.  (If the notice involves 
specific elements of a unit, the notice contains an element line for each such element). 

• The notice concludes with zero or more message lines.  (If the notice includes messages 
that are not specific to any particular element, the notice contains a message record for 
each such message). 

• Each notice occupies a minimum of two lines (SUMMARY and MESSAGE, or 
SUMMARY and ELEMENT, or all three). 

• There are no labels on the exported Excel file headings. 
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Exhibit 178. CSV Notice Search Results CSV File Column Key 

Column Attribute Name Definition 
  SUMMARY Lines 

A Notice ID The unique identifier for this notice. 
B Summary Record 

Indicator 
A summary record indicates the beginning of the data for the next 
notice in the file.  The value is always SUMMARY. 

C Timestamp The date and time at which the system generated this notice. 
D Equipment ID The equipment ID for the equipment (if any) related to this notice. 
E Equipment Group The equipment group for the equipment (if any) related to this notice. 
F Equipment Type 

Code 
The equipment type code for the equipment (if any) related to this 
notice. 

G Mechanical 
Designation 

The mechanical designation for the equipment (if any) related to this 
notice. 

H Pool ID The pool ID for the pool (if any) related to this notice. 
I Type The type of notice. 
J Event Code The event code for this notice. 
K Level The level for this notice. 
L User ID The user ID (if any) that originated the transaction resulting in this 

notice. 
M Status The status for this notice. 
N Maintenance 

Party Mark 
The mark of the maintenance party. 

  MESSAGE Lines 
A Notice ID The unique identifier for this notice. 
B Record Indicator Indicates the beginning of the message data for the Notice ID record.  

The value is MESSAGE. 
C Message The text of the message. 
  ELEMENT Lines 

A Notice ID The unique identifier for this notice. 
B Record Indicator Indicates the beginning of the data for elements in the Notice ID 

record.  The value is always ELEMENT. 
C Element ID The identifier for the type of element. 
D Pre-transaction 

Data 
The value of this element before the transaction that produced this 
notice. 

E Transaction Data The value of this element specified by the transaction that produced 
this notice. 

F Current Data The current value of this element. 
G Message 1 A message (e.g., an error message) regarding this element. 
H Message 2* A message (e.g., an error message) regarding this element. 
  . . . 

Etc. Message N* A message (e.g., an error message) regarding this element. 
* Each element record contains one or more messages. 

 



Umler® Maintenance 
Suspended Work  

 

Revised December 2013 127 Umler Version 4.8 

Suspended Work 
Many Umler Add, Modify, and update functions provide a processing option to Suspend the 
work. The user might need to verify data, or cannot resolve validation issues without guidance. 
When Suspend is chosen the Suspend Work page is displayed (Exhibit 82). The user should enter 
enough information to make the task easily recognizable for resuming the task. 

When a user is ready to resume suspended work: 

1. Select Maintenance> Suspended Work. The Suspended Work page is displayed  
(Exhibit 179). 

Exhibit 179. Suspended Work 

 

Default order is by oldest timestamp. To recall a recently suspended task, sort by Timestamp to 
bring the newest to the top of the display. Actions for this page include: 

• Resume Suspended Work 

• Delete Suspended Work 
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Resume Suspended Work 
2. Check the box beside the task to be resumed and select Resume. The appropriate Umler page 

is displayed with a Transaction Retrieved message (Exhibit 180). 

Exhibit 180. Transaction Retrieved (Update Pool Header) 

 

3. Complete the page in accordance with instructions for that task (For Exhibit 180, this would 
be the Update Pool Header task). 

Delete Suspended Work 
If a decision is made to delete an incomplete task: 

2. Check the box beside the task to be resumed and select Delete. The Confirm Delete 
Suspended Tasks page is displayed (Exhibit 181). 

Exhibit 181. Confirm Delete Suspended Tasks 

 

3. To delete the tasks, select Delete. Otherwise, select Cancel. The Suspended Work page is 
redisplayed and the deleted tasks are not in the list. 

 



Umler® Maintenance 
Manage Future Transactions  

 

Revised December 2013 129 Umler Version 4.8 

Manage Future Transactions 
The Manage Future Transactions function allows users to search for and delete any future 
effective transactions pertaining to equipment pools. To view future transactions: 

1. Select Maintenance> Manage Future Transactions. The Search Future Effective 
Transactions page is displayed (Exhibit 182). 

Exhibit 182. Search Future Effective Transactions 

 
2. Enter search criteria as desired. Red fields are mandatory. Field Descriptions for the top of 

the page are shown in Exhibit 183. 

Exhibit 183. Search  Future Effective Transactions Descriptions 

Field Description 

Future Effective 
Transaction ID(s) 

ID assigned to the future transaction (if known). 

Description Description previously entered for the future transaction 
Starting Future Effective 
Date 

Use the calendar picker ( ) to select the dates to be queried. 
Note: Default Date is today starting at 12:00 AM. 

Ending Future Effective 
Date 

Use the calendar picker ( ) to select the dates to be queried. 
Note: Default Date is 12/31/9999 at 11:59 PM. 

Transaction Type(s) Select from four available choices. 
User ID(s) Search for future transactions entered by specified user ID(s). 
Pool ID(s) Type 7-digit pool IDs to search for future transactions related to those 

pools. 
Equipment ID(s)  Type the specific equipment IDs (e.g., abcd123) or search with a range 

(e.g., abcd123-999) or a wildcard. See Exhibit 21 for more information. 
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3. Set the *Output to: drop-down to browser to have the search results displayed in the browser 
(default). Otherwise, select CSV. See Warning on page 18. 

4. (For browser only) Set the *Maximum Number of Results: field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

5. Select one of the processing options shown in Exhibit 184. 

Exhibit 184. Search Future Transactions Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See Exhibit 

185. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria. See Exhibit 36. 
 
Exhibit 185. Future Effective Transaction Search Results 

 

Actions for future transactions include: 

• To view the future transaction, select it ID link at the left. See Exhibit 186. 

• To delete the transaction, check the box beside the appropriate IDs, select Delete Future 
Effective Transaction from drop-down (only choice), and select OK. A confirmation 
page is displayed (Exhibit 187). 

Note: To change the date of a future transaction, delete the incorrect transaction, and then create 
a new future transaction with the new date. 

 
Exhibit 186. Future Effective Transaction Details 

 

When finished viewing the details, select Done to return to the search results. 
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Exhibit 187. Confirm Delete of Future Effective Transaction(s) 

 

To confirm the deletion of a future transaction, select Delete. Otherwise, select Cancel to return 
to the search results. 
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Upload/Download 
Exhibit 188. Upload/Download Menu 

 

Exhibit 189 describes the tasks available on the Upload/Download menu. 

Exhibit 189. Upload/Download Menu Items and Descriptions 

Menu Item Description 

Metadata Reference 
File 

Allows the user to download a revised metadata reference file. 

Bulk Upload 
Transactions 

Allows the user to upload CSV formatted records, such as pool assignments, 
Equipment Management codes, and car grade inspections.  This includes both 
new and corrected records. 

Upload Corrected 
Notices 

Allows the user to upload corrections or updates to CSV transactional records 
associated with received notices. This includes CSV-formatted text files. 

Request EMIS 3.2 
Refresh 

Allows the user to resynchronize the company’s local copy of the Umler pool 
and equipment data following an interruption of messaging or an error 
occurring at the company site for Umler 3.2.  The refresh functionality is not 
intended to synchronize a company’s local system with the complete Umler 
master file. The refresh functionality does not replace master data extracts. 

Request EMIS 3.1 
Refresh 

Allows the user to resynchronize the company’s local copy of the Umler pool 
and equipment data following an interruption of messaging or an error 
occurring at the company site for Umler 3.1.  The refresh functionality is not 
intended to synchronize a company’s local system with the complete Umler 
master file. The refresh functionality does not replace master data extracts. 
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Metadata Reference File 
Railinc uses a web application to establish changes to the metadata affecting the appearance of 
Umler interfaces and the content of drop-down, etc. This function is used to download a tested 
version of the current metadata. When the user selects Upload/Download>Metadata Reference 
File, a download panel is displayed (refer to Exhibit 33) to download the zipped metadata file. 

Bulk Upload Transactions 
Umler CSV transaction records in the correct format can be uploaded as a batch using the Bulk 
Upload Transactions function. When the user selects Upload/Download>Upload Transactions, 
the Upload Umler Transactions page is displayed (Exhibit 190). 

Exhibit 190. Upload Umler Transactions 

 

Follow the online instructions at the top of the page. 

When the upload has completed, the Upload Summary page is displayed (not shown). It contains 
the following information: 

• At the top of the page, the system displays the summary information for the upload 
process. 

• The system displays the total number of transactions processed from the uploaded file. 

• The system displays the number of transactions successfully validated and applied to the 
system. 

• The system displays the number of transactions that failed. A transaction might fail 
during parsing, validation, etc. 

• At the bottom of the page, the system displays the details of any failed transactions. For 
each failure, the system displays the line number of the transaction (in the file) that failed 
and a description of the reason for failure. 

• An email tickler is sent (if so configured—see Configure Ticklers) and the summary is 
stored in notice management. 
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Upload Corrected Notices 
 The system allows the user to download error notices in CSV format. The user can make the 
necessary corrections within the CSV file (see CSV Notice Search Results, on page 125) and then 
upload the file to apply the corrections to the system. The system only processes notices that 
include elements. The system uses the value in the Transaction Data field of each element record 
to reprocess the transaction. 

When the user selects Upload/Download> Upload Corrected Notices, the Upload Corrected 
Error Notices page is displayed (Exhibit 191). 

Exhibit 191. Upload Corrected Error Notices 

 

Follow the online instructions at the top of the page. 

As with the upload just described, the system displays the processing results to the user via the 
web interface and generates an informational tickler notice indicating the processing results. 
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Request EMIS 3.2 Refresh 
Note: In order to limit excessive use of system resources (e.g., bandwidth, CPU cycles, etc.), 

the system restricts the amount of refresh data that users can request. The system allows 
users to specify the desired refresh data by equipment ID(s), pool ID(s), or date/time 
range. 

 
When an authorized Umler 3.2 user selects Upload/Download>Request Umler 3.2 Refresh, the 
Refresh page is displayed (Exhibit 192). 

Exhibit 192. Refresh 

 

Refreshes can be done using Equipment Characteristics, Pool Data, or a Date/Time Range. 

Equipment Characteristics 
1. Select the Equipment Characteristics radio button. 

2. Type in Equipment IDs to be refreshed. See Exhibit 21 for information on entering 
multiple IDs. 

3. Select Submit to refresh the equipment. 
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Pool Data 
1. Select the Pool Data radio button. 

2. Type in Pool IDs to be refreshed. See Exhibit 21 for information on entering multiple IDs. 

3. Select pool options: 

a. Pool Header only—refreshes general information contained in the specified pool headers 

b. Pool Assignments only—refreshes equipment within the specified pools 

c. Both—refreshes both specified pool headers and assignments 

4.  Select Submit to refresh the pool data. 

Date/Time Range 
1. Select the Date/Time Range radio button. 

2. Set the Starting Date/Time for the refresh: 

a. Use the calendar picker ( ) to select the Starting Date. 

b. Type a 2-digit hour (01–12), and minutes (00–59). 

c. Select the AM or PM radio button. 

3. Set the Ending Date/Time for the refresh: 

a. Use the calendar picker ( ) to select the Ending Date. 

b. Type a 2-digit hour (01–12), and minutes (00–59). 

c. Select the AM or PM radio button. 

4. Select Submit to refresh the time range. 

Request EMIS 3.1 Refresh 
When an authorized Umler 3.1 user selects Upload/Download>Request Umler 3.1 Refresh, the 
Refresh page is displayed (Exhibit 192). 

Refer to Request EMIS 3.2 Refresh on page 135 for instructions—the process is identical. 
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Account Administration 
Exhibit 193. Account Administration 

 
Exhibit 194 describes the tasks available on the Account Administration menu. 

Exhibit 194. Account Administration Menu Items and Descriptions 

Menu Item Description 
Security Management Opens the Security Management page (Exhibit 195). 

Configure Ticklers Allows account administrators to specify which types of event notifications 
should be sent by Umler, and to whom. 

Usage Statistics Allows the user to download usage statistics in CSV format. 
 

Security Management 
The security module ensures that only authorized users can access specific equipment and pools, 
report inspections, or perform other procedures within the system. 

The Umler security module supports an administrator’s ability to manage access rights for intra-
company users, manage access rights given to other companies, manage access rights given by 
other companies, and transfer access rights to another company.  When managing access rights 
for intra-company users, Umler security allows the administrator to add, edit, delete, and/or clone 
access rights. When managing access rights given to other companies, the Umler security module 
allows the administrator to view existing rights, grant new rights, and/or revoke existing rights.  
When managing access rights given by other companies, the EMIS security module allows the 
administrator to assign and/or relinquish those rights to users within his company. This module 
also allows every user to view his access rights. 

Note: It is important to note the distinction between a company, a SCAC, and Equipment 
Initials. For the purposes of this system, a company owns one or more SCACs (Standard 
Carrier Alpha Code), and each SCAC owns one or more Equipment Initials. Umler relies 
on the IRF (Road Mark Register) to define the relationship between SCACs and 
Equipment Initials. 

 
Access rights are assigned in Umler by the company Umler administrator. Access rights include 
pool-related rights, equipment-related rights, inspection-related rights and view confidential data 
rights. 

For each access right, the administrator must specify the following characteristics: 

Timeframe of authority—The timeframe of authority defines the period (effective 
date/time to expiration date/time) during which the access right will exist. 
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Type of access—The administrator must specify the type of actions to which the access 
right applies: 

Equipment Access Rights—For an equipment-related access right, the administrator 
specifies one or more of the following types of access: 

• Update Equipment Management Codes 
• Non-Owner Self-As-Lessee Removal 
• Equipment - “Add to Pool” 
• Equipment - “Remove from Pool” 
• Update Equipment Maintenance Party 
• Add Equipment 
• Update Equipment 
• Delete Equipment 

Pool Access Rights—For a pool-related access right, the administrator specifies one or 
more of the following types of access: 

• Add Pool Header 
• Update Pool Header 
• Delete Pool Header 
• Pool Assignment / Unassignment 

Inspection Access Right—For an inspection access right, the administrator specifies 
timeframe, marks, and equipment for which the user can report inspections. 

View Confidential Data Access Right—For inter-company rights only, a view 
confidential data access right, the administrator specifies timeframe, marks, and 
equipment for which the user can view confidential data. 

Range of equipment, pools, and inspection rights—For an equipment-related access 
right, the administrator specifies to which pieces of equipment the access right applies. The 
administrator restricts access to any one of the following: 

All Equipment The access right applies to all equipment controlled by the 
company. 

SCAC(s)   The administrator may specify one or more SCACs (from the set 
of SCACs managed by the administrator) to which the access right 
applies. 

Equipment Initials The administrator may specify one or more equipment initials 
(from the set of car initials managed by the administrator) to 
which the access right applies. 

Equipment 
Group(s) 

The administrator may specify one or more equipment groups 
(e.g. box cars, tank cars, locomotives, etc.) to which the access 
right applies. See Equipment Group(s) in Exhibit 20.  

Equipment IDs or 
Equipment Series 

The administrator may specify one or more equipment IDs to 
which the access right applies. 
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Range of pools—For a pool-related access right, the administrator specifies to which pools 
the access right applies. The administrator restricts access to one of the following: 

All pools The access right applies to all pools controlled by the company. 
Pool ID(s) The administrator may specify one or more pool IDs to which the 

access right applies.   
 
When the user selects Account Administration>Security Management, the Security 
Management page is displayed (Exhibit 195). 

Exhibit 195. Security Management 

 
There are four security management task groups: 

• Administer Access Rights Internal to My Company 
• Administer Access Rights Involving Other Companies 
• Search User Access Rights 
• Transfer Access Rights Between Companies (Railinc Administrators only) 

 
All access rights activities begin on this page. 
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Administer Access Rights Internal to My Company 
The following actions pertain to access rights internal to the user’s company. 

• View My Access Rights—for all users 

• Manage Intra-Company User Access Rights—Company Administrators only 

• Manage Security Profiles—Company Administrators only 

• Add/Remove User to/from Security Profiles—Company Administrators only 

View My Access Rights 
Note: This security management option is available to all Umler users. 
 
On the Security Management page (Exhibit 195), select View My Access Rights. The View a 
User’s Access Rights page is displayed (Exhibit 196). 

Exhibit 196. View a User’s Access Rights 

 

To view the details of a specific access right, select the radio button beside the access and select 
View. The details of the access are displayed. Exhibit 197 show the access details for the 
poolright access listed in Exhibit 196. 
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Exhibit 197. Pool Access Right (view only) 

 

Select the company link to view the Company Contact information page (similar to Exhibit 60). 

No other actions are available on this page. When finished viewing, select Done. 

Manage Intra-Company User Access Rights 
A company Umler administrator can update a user’s access rights.  The administrator can grant 
new access rights, modify existing access rights, delete existing access rights, or copy access 
rights from another user. 

Warning: Before assigning access rights, check the user’s existing rights to ensure rights are 
not duplicated or contradicted. 

 
To manage user access rights: 

1. On the Security Management page (Exhibit 195), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 198). 
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Exhibit 198. Update a User’s Access Rights 

 

2. Scroll and select the radio button beside the user to be updated. Then select Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 199). 

Exhibit 199. Update a User’s Access Rights (for selected user) 

 

The following actions are possible: 

Add Pool Right 
Add Equipment Right 
Add Inspection Right 
Edit 
Delete 
Clone Rights from another User 
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ADD POOL RIGHT 
Use to add pool rights. When Add Pool Right is selected, the Pool Access Right page is 
displayed for the selected user ID (Exhibit 200). 

Exhibit 200. Pool Access Right (for user) 

 
3. Complete the fields (mandatory fields are in red): 

Exhibit 201. Pool Access Right Field Descriptions 

Field Description 

*Description Enter a description of the access rights. It can be simple, like Pool Rights 
or specific, like BOXC Pools Only, or Hoppers and Gondolas Pool to 
indicate wider scope. 

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted pool 
right. The Effective date defaults to today’s date, and must be greater than 
or equal to today’s date. The Expiration Date must be greater than or equal 
to the Effective Date. 

Range of Pool Select either the All Pools radio button (default) or the Pool ID(s) radio 
button.  For Pool ID(s), enter either specific Pool IDs or a range. 

Type of Access Select one or more of the available access types (allowed activities) to 
assign (Press Ctrl key for multiple selections.): 

• Add a Pool Header 
• Update a Pool Header 
• Delete a Pool Header 
• Pool Assignment / Unassignment 

 

4. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 
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ADD EQUIPMENT RIGHT 
Use to add a equipment rights. When Add Equipment Right is selected, the Equipment Access 
Right page is displayed for the selected user ID (Exhibit 202). 

Exhibit 202. Equipment Access Right (for user) 

 

3. Complete the fields (mandatory fields are in *red): 

Exhibit 203. Equipment Access Right Field Descriptions 

Field Description 

*Description Enter a description of the access rights. It can be simple, like Equipment 
Rights or specific, like BOXC Equip, or Hopper and Gondola Equip to 
indicate wider scope. For equipment, it might include SCACs in the 
description. 

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted 
equipment right. The Effective date defaults to today’s date, and must be 
greater than or equal to today’s date. The Expiration Date must be greater 
than or equal to the Effective Date. 

Range of Equipment Select either the All Equipment radio button (default) or: 
• SCAC(s) – Select one or more listed railroad marks. 
• Initial(s) – Select one or more listed equipment initials. 
• Equipment Group(s) – Select one or more listed equipment types. 
• Equipment – Enter specific equipment Marks and numbers 

(Equipment IDs). 
Press Ctrl key for multiple selections. 
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Field Description 

Type of Access Select one or more of the available access types (allowed activities) to 
assign (Press Ctrl key for multiple selections.): 

• Non-Owner Self-As-Lessee Removal 
• Equipment - “Add to Pool” 
• Equipment - “Remove from Pool” 
• Add Equipment 
• Modify Equipment 
• Delete Equipment 

 
4. (Optional) Select the Count Equipment button to determine the number of equipment units 

included in the rights assigned. 

Exhibit 204. Count for Access Rights 

 

5. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 
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ADD INSPECTION RIGHT 
Use to add an inspection rights. When Add Inspection Right is selected, the Inspection Access 
Right page is displayed for the selected user ID (Exhibit 205). 

Exhibit 205. Inspection Access Right (for user) 

 

3. Complete the fields (mandatory fields are in *red): 

Exhibit 206. Inspection Access Right Field Descriptions 

Field Description 

*Description Enter a description of the access rights. It can be simple, like Inspection 
Rights or specific, like BOXC Inspection, or Hopper and Gondola 
Inspection to indicate wider scope.  

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted 
inspection right. The Effective Date defaults to today’s date, and must be 
greater than or equal to today’s date. The Expiration Date must be greater 
than or equal to the Effective Date. 

Authorize reporting as 
the following marks 

Use the All Marks check box to (default) select all marks or uncheck this 
box and select individual listings under the Mark(s) heading. Press Ctrl 
key for multiple selections. 

Authorize reporting for 
the following 
inspections 

Use the All Inspections check box to select all inspection types (default) or 
uncheck this box and select individual listings under the Inspection Type(s) 
heading (refer to Exhibit 130). Press Ctrl key for multiple selections. 
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Field Description 

Range of Equipment Select either the All Equipment radio button (default) or: 
• SCAC(s) – Select one or more listed railroad marks. 
• Initial(s) – Select one or more listed equipment initials. 
• Equipment Group(s) – Select one or more listed equipment types. 
• Equipment – Enter specific equipment Marks and numbers 

(Equipment IDs). 
Press Ctrl key for multiple selections. 

 
4. (Optional) Select the Count Equipment button to determine the number of equipment units 

included in the rights assigned. 

5. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 

EDIT 
Use to edit or view an existing access right. To edit (or view) user access rights: 

1. On the Security Management page (Exhibit 195), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 198). 

2. Scroll and select the radio button beside the user to be updated. Then select Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 199). 

3. Select the radio button beside the access right to be viewed or edited and select Edit. The 
<Pool, Equipment, or Inspection> Access Rights page is displayed accordingly. A statement 
indicates the user ID that is being edited. The page show the existing settings. 

Note: If no changes are needed, select Cancel to return to the Update a User’s Access 
Rights page. 

 
4. Modify the content as described in Update Access rights as described in Edit (Access rights) 

on page 147: 

5. When all changes have been made: 

a. (Optional) Select the Count Equipment button to determine the number of equipment 
units included in the revised rights assigned. See Exhibit 204. 

b. Select Save. The Update a User’s Access Rights page is redisplayed with the revised 
rights displayed. 
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DELETE 
Use this option to delete an existing access right. To delete user access rights: 

1. On the Security Management page (Exhibit 195), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 198). 

2. Scroll and select the radio button beside the user to be updated. Then select Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 199). 

3. Select the radio button beside the access right to be deleted and select Delete. The Confirm -  
Delete an Access Right page is displayed (Exhibit 207). 

Exhibit 207. Confirm - Delete an Access Right 

 

4. If unsure about the deletion select Cancel. Otherwise, select Delete to confirm. The Update a 
User’s Access Rights page is redisplayed without the deleted access right listed. 

CLONE RIGHTS FROM ANOTHER USER 
Use this option to clone access rights from another user. To clone rights: 

1. On the Security Management page (Exhibit 195), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 198). 

2. Scroll and select the radio button beside the user to be updated. Then select Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 199). 

3. Select Clone Rights from Another User. The Select Access Right Source page is displayed 
(Exhibit 208). 
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Exhibit 208. Select Access Right Source 

 
4. Scroll and select the radio button beside the user whose access rights are to be cloned 

(copied). Then select Clone Rights. The Confirm Clone Access Rights page is displayed with 
the selected source user’s access rights (Exhibit 209). 

Exhibit 209. Confirm Clone Access Rights 

 
5. If unsure about the rights, select Cancel to exit. Otherwise, select Confirm Clone Rights. 

The Update a User’s Access Rights page is redisplayed with the new cloned rights. The 
effective date defaults to the current date. 

Manage Security Profiles 
The manage security profiles option allows a Company Umler Administrator to create security 
profiles for his/her company. A profile represents a collection of access rights.  The Company 
Umler Administrator can then associate a profile to multiple users in one step, thus simplifying 
access rights management. 

ABOUT COMBINING POOL AND EQUIPMENT ACCESS RIGHTS 
A company administrator can restrict a user activity to certain pools, equipment groups, 
equipment initials, or equipment units (equipment initial/numbers). 

By combining Pool Rights along with Equipment Rights for a user, the administrator can create 
tighter security around that user’s access rights. For example, the administrator can restrict the 
equipment groups, equipment initials, or equipment units that a pool operator could assign to a 
pool. 
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Example 1: 
• User is granted Pool Rights for All Pools. 
• User is also granted Equipment Rights for Gondolas only. 

Result: The user has rights to all pools but can only assign Gondolas to those pools. 

Example 2: 
• BNSF User is granted Pool Right for a single specific Pool Id (NNNNNNN). 
• BNSF User is also granted Equipment Rights for Equipment Initial ATSF. 

Result: The user has rights only to pool NNNNNNN and can only assign Equipment 
Initials of ATSF to that specific pool. 

To work with security profiles: 

1. On the Security Management page (Exhibit 195), select Manage Security Profiles. The 
Manage Security Profiles page is displayed (Exhibit 210). 

Exhibit 210. Manage Security Profiles 

 

2. Select from the following options: 

a. Select Add to add a new security profile. See Adding a New Security Profile on 
page 150. 

b. Select the ID hyperlink of a displayed security profile to edit that profile. See Editing a 
Security Profile on page 152. 

c. Check the box beside a listed security profile and select Clone to clone an existing 
security profile. The Administrator should select the closest profile to the new one to be 
created. See Cloning a Security Profile on page 153. 

d. Check the box beside a listed security profile and select Delete to delete that profile. See 
Deleting a Security Profile on page 154. 

ADDING A NEW SECURITY PROFILE 
When the user selects Add on the Manage Security Profiles page (Exhibit 210), the Add Security 
Profile page is displayed (Exhibit 211). 
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Exhibit 211. Add Security Profile 

 
1. Type in the *Security Profile Name. It is suggested that these be role-related and intuitive. 

For example, Inspectors, Manager Full Rights, or Boxcar Pool Manager, etc. 

2. (Optional) Check the box beside those users ID to be the new security profile users. 
Assignments can be done later during the security profile edit.  

a. If needed, select the User ID link to view contact information for that user. 

b. Select View Individual Access Rights link to view access rights already assigned to that 
user. 

3. Select Save to save the profile name. The Edit Security Profile page is displayed with a 
success message and additional buttons (Exhibit 212). 

Exhibit 212. Edit Security Profile (for new profile) 

 

Note: A new profile has no rights assigned. A profile ID is assigned automatically by Umler. 
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4. Add Pool, Equipment, and Inspection rights and Save as described in: 

• Exhibit 201. Pool Access Right Field Descriptions 

• Exhibit 203. Equipment Access Right Field Descriptions 

• Exhibit 206. Inspection Access Right Field Descriptions 

5. (Optional) Check the box beside those user IDs to be the new security profile users. 
Assignments can be done later during subsequent security profile edits. 

6. When all rights and users have been added, select Save and Return to save the created 
security profile and return to the Manage Security Profiles page. The new profile is listed. 

EDITING A SECURITY PROFILE 
When the user selects a profile ID link on the Manage Security Profiles page (Exhibit 210), the 
Edit Security Profile page is displayed (Exhibit 213). 

Exhibit 213. Edit Security Profile (for existing profile) 

 
Perform one of the following actions: 

Add profile users—Check the box beside the user IDs and select Save to remain on the Edit 
Security Profile page or Save and Return to save the profile user additions and return to the 
Manage Security Profiles page. 
Delete profile users—Uncheck the box beside the user IDs and select Save to remain on the Edit 
Security Profile page or Save and Return to save the profile user deletions and return to the 
Manage Security Profiles screen. 
Edit existing access rights—Select the View Individual Access Rights link. The <Pool, 
Equipment, or Inspection> Access Rights page is displayed accordingly. Modify and Save the 
content as described in Update Access rights as described in Edit (Access rights) on page 147. 
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Add new pool rights, equipment rights, or inspection rights—Select the corresponding 
command button. Enter rights and Save as described in the following: 

• Exhibit 201. Pool Access Right Field Descriptions 

• Exhibit 203. Equipment Access Right Field Descriptions 

• Exhibit 206. Inspection Access Right Field Descriptions 

Delete access rights—Check the box beside the Pool, Equipment, or Inspection Rights to be 
removed and select Delete. A confirmation page is displayed with a choice to Cancel or Delete. 

CLONING A SECURITY PROFILE 
When the user checks the box beside the profile ID link on the Manage Security Profiles page 
(Exhibit 210) and selects Clone, the Clone Security Profile page is displayed (Exhibit 214). 

Exhibit 214. Clone Security Profile 

 
The unnamed new security profile contains exactly the same rights as its source and also has the 
same user population. To complete the cloning process: 

1. Type the new cloned Security Profile Name. 

2. Unselect All users in the User field. 

3. (Optional) Check the box beside those users IDs to be the new security profile users. Profile 
users can be added later during an edit session. 

4. Update Access rights as described in Edit (Access rights) on page 147. 

5. When all users and right have been adjusted, select Save. The Manage Security Profiles page 
is displayed with the new, cloned profile. Umler automatically assigns a Profile ID. 
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DELETING A SECURITY PROFILE 
When the user checks the box beside the profile ID link on the Manage Security Profiles page 
(Exhibit 210) and selects Delete, the Confirm Delete of Security Profile(s) page is displayed 
(Exhibit 215). 

Exhibit 215. Confirm Delete of Security Profile(s) 

 

If unsure about the deletions, select Cancel. Otherwise, select Delete. The Manage Security 
Profiles page is redisplayed with a success message, and the deleted profiles are not listed. 

Add/Remove User to/from Security Profiles 
This function allows the administrator to add/remove multiple security profiles for a single user. 
If more than one user is involved, it can be quicker to edit the security profiles and assign 
multiple users during the edit session. 

To add/remove user to/from security profiles: 

1. On the Security Management page (Exhibit 195), select Add/Remove User to/from Security 
Profiles. The Add/Remove User to/from Security Profiles page is displayed (Exhibit 216). 

Exhibit 216. Add/Remove User to/from Security Profiles 

 

2. Select the radio button beside the user ID to be added or removed as a profile user and select 
Select. The second Add/Remove User to/from Security Profiles page is displayed (Exhibit 
217). 
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Exhibit 217. Add/Remove User to/from Security Profiles (w/profile Add/Remove windows) 

 

The user being modified is listed below the page title. 

3. Add or remove profiles: 

a. To add a profile, select/highlight a profile from the Available Profiles window and select  
the right arrow ( ). The selected profile moves to the Profiles Currently Assigned to 
this User window. 

Note: To add all profiles to the user, select the double right arrow ( ). No profile 
selection is necessary. 

 
b. To remove a profile, select/highlight a profile the Profiles Currently Assigned to this User 

window and select the left arrow ( ).  

Note: To remove all profiles from the user, select the double left arrow ( ). No profile 
selection is necessary. 

 
4. Select Save to save changes and return to the Security Management page.  A successful 

update message is displayed. 
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Administer Access Rights Involving Other Companies 
An administrator grants access rights—to equipment, inspections, and pools, as well as access to 
confidential data controlled by his/her company (grantor)—to another company (grantee). 

The grantor’s administrator selects a grantee (by company) from the list of EMIS-participating 
companies.  The administrator updates the grantee’s access rights to the grantor’s data.  The 
grantor’s administrator can grant new access rights to the grantee or revoke any of the grantee’s 
existing access rights. 

A “handshake” between companies is required for Inter-Company access rights.  A grantee must 
accept a grant before it becomes effective. 

The following actions pertain to access rights involving other companies: 

• Manage Inter-Company Right/Profiles Granted by My Company—Company 
Administrators only 

• Manage Inter-Company Access Rights Granted to My Company—Company 
Administrators only 

• Manage Inter-Company Profiles Granted to My Company—Company Administrators 
only 

• Special SSO Security Request for Non-participating Companies—Company 
Administrators only 

• View Status of Special Umler SSO Requests—Company Administrators only 

Manage Inter-Company Right/Profiles Granted by My Company 
This function allows a grantor administrator to grant access rights for equipment, inspections, and 
pools controlled by his/her company as well as access to confidential data. To work with access 
rights granted to other companies: 

1. On the Security Management page (Exhibit 195), select Manage Inter-Company 
Right/Profiles Granted by My Company. The Inter-Company Right/Profiles Granted by 
My Company page is displayed (Exhibit 218). 
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Exhibit 218. Inter-Company Right/Profiles Granted by My Company 

 

This page shows existing rights by Company. If a new company is to be added, select the radio 
button beside the Add a company drop-down. The drop-down becomes active (Exhibit 219). 
Locate the company and select. The drop-down closes with the selection showing. 

Exhibit 219. Add a company 

 

2. Otherwise, select the radio button beside the existing company listed whose access is to be 
added to or revised. 

3. Choose one of the following options: 

Grant Access Rights—Opens the Update Access Rights page for the selected company 
(Exhibit 220). 

Grant Profiles—Opens the Manage Security Profiles page for the selected company  
(Exhibit 223). 



Umler® Account Administration 
Security Management | Administer Access Rights Involving Other Companies  

 

Revised December 2013 158 Umler Version 4.8 

GRANT ACCESS RIGHTS 
When the administrator selects a grantee, and selects Grant Access Rights on the Inter-Company 
Right/Profiles Granted by My Company page, the Update Access Rights page is displayed. 

Exhibit 220. Update Access Rights 

 

All existing rights for the selected company are shown. Access right can have the statuses shown 
in Exhibit 221. 
Exhibit 221. Access Rights Status 

Status Description 
Accepted Access rights accepted by the grantee company. 
Declined Access rights declined by the grantee company. 
Expired Access rights have lapsed due to timeframe. 
Pending Access granted by administrator’s company, but not accepted or declined 

currently. 
Relinquished Access right accepted by grantee, but then surrendered. 
Revoked Access rights removed by the grantor company. 

 
Actions allowed on this page include: 

Add Pool Right—Opens the Pool Access Right page (similar to Exhibit 200). Refer to Add Pool 
Right on page 143. The new pool right might include the grantee’s mark as part of the 
description. 

Add Equipment Right—Opens the Add Equipment Right page (similar to Exhibit 202). Refer to 
Add Equipment Right on page 144. The new equipment right might include the grantee’s mark as 
part of the description. 

Add Inspection Right—Opens the Inspection Access Right page (similar to Exhibit 205). Refer 
to Add Inspection Right on page 146. The new inspection right might include the grantee’s mark 
as part of the description. 

Add View Confidential Data Right—Opens the View Confidential Data Access Right page 
(Exhibit 222). Refer to Add Equipment Right on page 144 for instructions. The new confidential 
equipment right might include the grantee’s mark as part of the description. A limited Timeframe 
of Authority can be imposed as well. 
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Exhibit 222. View Confidential Data Access Right 

 

View—Select the radio button beside the grantee access to be viewed and select View. A read-
only page (similar to Exhibit 197) opens. When finished viewing, select Done to return to the 
Update Access Rights page. 

Revoke—Select the radio button beside the grantee access to be revoked and select Revoke. A 
confirmation page is displayed. If unsure about revoking the rights, select Cancel. Otherwise, 
select Revoke.  The Update Access Rights page is redisplayed with the access right status shown 
as revoked. 

Done—Returns User to the Inter-Company Right/Profiles Granted by My Company page 
(Exhibit 218). 

GRANT PROFILES 
When the administrator selects a grantee, and selects Grant Profiles on the Inter-Company 
Right/Profiles Granted by My Company page, the Manage Security Profiles page is displayed 
(Exhibit 223). 

Exhibit 223. Manage Security Profiles 

 

Note: If no security profiles (groups of rights) have been established with this company 
previously, the list shown is empty (no profiles). 
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The grantor administrator can do the following tasks: 

Security Profile ID link—For Pending profiles, selecting the Security Profile ID link opens the 
Edit Security Profile page (similar to Exhibit 213). Refer to Editing a Security Profile on page 
152. No “User” section is included when editing profiles for other companies, since the user 
population is unknown. Modification of the various rights and dates are the same. 

Add—Add a new security profile for the grantee company. The Add Security Profile page is 
displayed (similar to Exhibit 211). The Security Profile Name should include the grantor’s Mark, 
since, once accepted by the grantee, the profile is included in the profiles available for assigning 
to grantee users. Refer to Adding a New Security Profile on page 150. No “User” section is 
included when creating profiles for other companies, since the user population is unknown. 
Assignment of the various rights and dates are the same. 

Revoke—Check the box beside the profile to be revoked and select Revoke. There is NO 
warning prior to the revocation, and the status changes to revoked. 

Select Done to return to the Security Management page. 

Manage Inter-Company Access Rights Granted to My Company 
This functions allows the grantee administrator to accept, decline, relinquish, and assign users to 
access rights granted by other companies. To work with access rights granted by other 
companies: 

1. On the Security Management page (Exhibit 195), select Manage Inter-Company Access 
Rights Granted to My Company. The Inter-Company Access Rights Granted to My 
Company page is displayed (Exhibit 224). 

Exhibit 224. Inter-Company Access Rights Granted to My Company 

 
The status of each access right is described in Exhibit 221. 



Umler® Account Administration 
Security Management | Administer Access Rights Involving Other Companies  

 

Revised December 2013 161 Umler Version 4.8 

2. To view an access right, select the radio button beside the desired access and select View. 
The View <Type> Access Right page is displayed (Exhibit 225). The title of the View page 
reflects the type of access granted (Pool, Equipment, Inspection, or Confidential Data). 

Exhibit 225. View <Type> Access Right 

 

Depending on the type of access granted and its status, available actions vary. 

Exhibit 226. Status-Based Actions for View 
 Actions Available 

Status Accept Assign 
to User 

Assign  
to Profile Decline Done Relinquish 

Accepted       
Declined       
Expired       
Pending       

Relinquished       
Revoked       

 
Accept—Accept the grantor’s Pending access right. The status changes to Accepted and new 
actions are available (see Exhibit 226). 

Decline—Declines the grantor’s Pending access right. The status changes to Declined and No 
further actions are available (see Exhibit 226). 

Assign to User—For Accepted access rights, opens the Intra-Company User List (Exhibit 227). 
See Assign to User on page 162. Only one user can be assigned at a time. If multiple users need 
this right, the administrator may choose to assign to a profile instead. 

Assign to Profile—Allows the administrator to “add” an Accepted access right to an existing 
security profile. Opens the Manage Security Profiles page (Exhibit 210). See Assign to Profile on 
page 163. 

Relinquish—Allows the administrator to surrender an Accepted access right. The status becomes 
Relinquished and new actions are available (see Exhibit 226). 
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ASSIGN TO USER 
When the administrator views an accepted access right and selects Assign to User, the Intra-
Company User List is displayed (Exhibit 227).  
Exhibit 227. Intra-Company User List 

 . . . 

 
1. Scroll and select the radio button beside the desired user. Scroll to the bottom of the page 

(press End) and select Select. The View <Type> Access Right page is displayed with the 
selected user identified under the page title (Exhibit 228). 

Exhibit 228. View <Type> Access Right (during user assignment) 

 

2. Adjust the allowable timeframe if the grantor’s Effective Date begins before the current date. 

3. To assign the right to the user, select Save. The View <Type> Access Right page is 
redisplayed with a success message. 
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ASSIGN TO PROFILE 
If an accepted right is needed by several users, the administrator can choose to “add” the right to 
an existing company security profile. The access right would then apply to all users of the profile. 
When the administrator views an accepted access right and selects Assign to Profile, the Intra-
Company Security Profile List page is displayed (Exhibit 229). 

Exhibit 229. Intra-Company Security Profile List 

 

1. Select radio button beside the security profile where the grantor right is to be added, and 
select Select. The <Type> Access Right page is displayed (Exhibit 230). The ID of the 
security profile that is being added to is identified under the page title. In Exhibit 230, the 
security profile ID is 11. 

Exhibit 230. <Type> Access Right 
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2. Adjust the allowable timeframe if the grantor’s Effective Date begins before today. 

3. To assign the right to the profile select Save. The <Type> Access Right page is redisplayed 
with a success message. 

4. Use the Intra-Company Manage Security Profiles function to add multiple user to the 
adjusted security profile. See Editing a Security Profile on page 152. 

Manage Inter-Company Profiles Granted to My Company 
This functions allows the grantee administrator to accept, decline, relinquish, and assign users to 
security management profiles granted by other companies. To access security profiles granted by 
other companies to the grantee: 

1. On the Security Management page (Exhibit 195), select Manage Inter-Company Profiles 
Granted to My Company. The Manage Security Profiles page is displayed (Exhibit 231). 

Exhibit 231. Manage Security Profiles (Inter-Company) 

 

Profiles that are in Pending status can be processed. 

2. To decline the profile, check the box beside the profile and select Decline. The status 
becomes Declined. Nothing more can be done with the profile. 

3. To accept the Pending profile, check the box beside the profile and select Accept. The status 
becomes Accepted, a success message is shown, and the profile ID is a hyperlink. 

Note: Umler also lists this inter-company security profile in the Available Profiles on the 
Add/Remove User to/from Security Profiles page (Exhibit 217). See Add/Remove 
User to/from Security Profiles on page 154 for additional instructions. 

 
Exhibit 232. Manage Security Profiles (after acceptance) 

 

4. To immediately add users, select the profile ID link. The Edit Security Profile page for the 
inter-company profile is displayed (Exhibit 233). 
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Exhibit 233. Edit Security Profile (Inter-Company) 

 

5. Check the box beside the User IDs who need to have the new inter-company profile assigned, 
and select Save. For more information about Editing Security Profiles, see Editing a Security 
Profile on page 152. 

Special SSO Security Request for Non-participating Companies 
This function can be used to request full SSO Umler Administrative rights on behalf of another 
company (hereafter called the Approver). The Approver might be a very small railroad without 
access to SSO/Umler, and has contracted with an agency or other road (hereafter called the 
Requestor) to handle its equipment-related tasking. This process serves as a Letter of 
Authorization (LOA). 

To be able to act on behalf of the Approver: 

• The Requestor must submit a valid request. 
• The Approver must approve the request. 
• The Railinc Umler Administrator must verify the request approval in Umler. 
• The Railinc Umler Administrator must establish the roadmark authorizations in SSO. 
• The Railinc Umler Administrator must implement the approved request in Umler. 
• The Requestor (company Admin), must assign a Requestor contact for the Approver 

marks in FindUs.Rail. 
• The Requestor (company Admin), must assign appropriate rights to their Umler users. 

These tasks are described elsewhere in this guide (or in the SSO and Launch Pad Administrator 
Guide). Refer also to FindUs.Rail at https://www.railinc.com/rportal/web/guest/findus.  
Notification e-mails are sent throughout the process. 

1. On the Security Management page (Exhibit 195), select Special SSO Security Request from 
Non-participating Companies. The Inter Company Authorization Request page is displayed 
(Exhibit 234). 

https://www.railinc.com/rportal/web/guest/findus
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Exhibit 234. Inter Company Authorization Request 

 
2. Complete the required fields. 

a. Request Authorization for Marks—type the marks being requested 
b. Name—Type the name of the Approver. (e.g., John n Doe) 
c. Company Name—Company Name of Approver (e.g., Very Small Railroad, Inc.) 
d. Email Address—Email for Approver (e.g., John.Doe@VerySmallRR.com) 
e. Phone Number— Approver’s phone number in AAA XXX-NNNN format 
f. Address 1—Mailing address of Approver (Address line 2 as needed) 
g. City—City of Approver 
h. State/Province—Use 2-character where possible 
i. ZIP Code—ZIP code for address 
j. Country—Country of Approved (e.g., US) 
k. This authorization is requested through the following date—Use calendar picker to 

choose an end date. For no end date, use 12-31-9999. 
l. (optional) Message to the Approver—Appropriate comments (e.g., Let us know if you 

need other marks handled. ) 

3. Select Submit. A confirmation message is displayed (Exhibit 235) 

Exhibit 235. Inter Company Authorization Request Confirmation 
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a. A confirming e-mail is sent to the requestor.  

b. An e-mail is sent to the approver. The approver e-mail contains a link to a website (not 
shown) where the request can be viewed and then either rejected or approved.  

View Status of Special Umler SSO Requests 
Once an Intercompany Authorization Request has been submitted, the requestor can check the 
status of the requests. To check the status: 

1. On the Security Management page (Exhibit 195), select View Status of Special Umler SSO 
Request. The Search Special Umler SSO Requests page is displayed (Exhibit 236). 

Exhibit 236. Search Special Umler SSO Requests 

 
2. Enter search criteria. 

a. Approver Status can be: 

• All (finds everything, recommended) 
• Approved 
• Pending 
• Rejected 

b. User Mark (specific known marks for an Approver) 

3. Select Search. The Search Special Umler SSO Requests page is redisplayed (Exhibit 237). 

Exhibit 237. Search Special Umler SSO Requests (results) 

 

This page is for viewing only. As needed, select the Search Criteria tab to modify the search 
criteria and do a different search. To exit the page, select another menu item. 
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Search User Access Rights 
An administrator can search for access rights by Access Right (Pool, Equipment, Inspection, and 
View Confidential Data), by Type (specific activities) , by user ID, by status (active and inactive), 
and by timeframe. 

To search User Access Rights: 

1. On the Security Management page (Exhibit 195), select Search User Access Rights. The 
Search Access Rights page is displayed (Exhibit 238). 

Exhibit 238. Search Access Rights 

 

Exhibit 239. Search Access Right Field Descriptions 

Field Description 

User ID(s) Search for access rights assigned to specific users by entering User IDs in this 
field. Separate multiple IDs using the delimiters shown in Exhibit 21 (generally a 
single space).  

Access Right(s) Select one or more available access rights: Equipment, Inspection, Pool, and 
View Confidential Data. Hold Ctrl key to make multiple selections. 

Type of Access Select one or more available types of access. Hold Ctrl key to make multiple 
selections. 

Status Default is to have neither Status selected. Check Active to search only currently 
effective access rights. Check Inactive to search expired rights. 

Timeframe of 
Authority 

Specify the Effective Date and the Expiration Date for the access right. The 
Effective date defaults to today’s date. The Expiration Date must be greater than 
or equal to the Effective Date. If a Status box is checked, this field is 
unavailable. 
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Viewing Specific Users’ Rights 
To see what access rights a specific user currently has, type the user ID in the User ID(s) field, 
check Active Status and select Search. The Search Access Rights Results page is displayed 
(Exhibit 240). To modify searches, select the Search Criteria tab, revise the criteria, and reselect 
Search. 

Exhibit 240. Search Access Rights Results (for single user ID) 

 

The results list contains a Right Source column that identifies whether the access right is sourced 
from the user, or a security profile. The User right ID/or profile ID column contains the unique 
IDs assigned by Umler for these rights or profiles as selectable links. 

To view the details of the access rights, select User Right/Profile ID link in the first column. 
Depending on whether the link represents a right or a profile, the <Type> Access Right (view-
only) or the Edit Security Profile page for the selected link is displayed (Exhibit 241). 

Note: All access right detail pages via Search are read-only, so to remove individual access 
rights for the user, refer to Manage Intra-Company User Access Rights on page 141. 

 
Exhibit 241. Edit Security Profile (for selected link 384) 
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The administrator can choose to “unassign” the user from this profile by unchecking the user ID 
and selecting Save. To see the details of the specific access rights, the administrator can select the 
ID link(s) shown in the Access Rights tab to view a read-only version (Exhibit 242). Select 
Cancel to return to the Edit page. 

Exhibit 242. Equipment Access Right (read-only view) 

 

Searching by Rights 
An administrator can search for users who have specific rights assigned to them (or even specific 
types of access). 

On the Search Access Rights page, select search criteria. In Exhibit 243, the criteria includes 
inspection access rights for locomotive-related tasks. Check Active status and select Search. The 
results are shown in Exhibit 244. 
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Exhibit 243. Search Access Rights (for locomotive inspection tasks) 

 

Exhibit 244. Search Access Right Results (for locomotive-related inspections) 

 

There is one security profile for the specified rights and 22 individual access rights that contain at 
least one of the specified rights and tasks. To view the details for the profile or rights, select the 
links in the left column. Refer to the Viewing Specific Users’ Rights on page 169 for information 
about link detail pages. 



Umler® Account Administration 
Security Management | Transfer Access Rights Between Companies  

 

Revised December 2013 172 Umler Version 4.8 

Transfer Access Rights Between Companies 
Note: These tasks are for Railinc Administrators only. 
 
When large groups of equipment are transferred from one company to another, the Umler record 
rights must also be transferred to allow further changes to the record (e.g., modify, pool 
assignment/unassignment) by the new company. 

Manage Access Rights Transferred by My Company 
To release equipment in Umler to another road: 

WARNING: Ensure the Company requesting to transfer the equipment to another road 
understands that once the equipment is accepted by the other road, the requesting 
company can no longer update those transferred Umler records, or see any 
confidential data (regardless of the stencil mark)—the transfer is immediate. 

 
1. Select Account Administration>Security Management, the Security Management page is 

displayed (Exhibit 195). 

2. Select the Manage Access Rights Transferred by My Company link. The Access Rights 
Transferred by My Company page is displayed (Exhibit 245). 

Exhibit 245. Access Rights Transferred by My Company 

 

3. Select Create New Access Right Transfer. The Transfer Access Right page is displayed 
(Exhibit 246). 
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Exhibit 246. Transfer Access Right 

 
4. Select the Target Company from the drop-down. 

5. Select the type of access being transferred. In Exhibit 246, BNSF is transferring equipment 
ID BNSF666667 to CSXT. 

6. Select Transfer. The Confirm Transfer page is displayed (Exhibit 247). 
Exhibit 247. Confirm Transfer 

 
7. Select Transfer a second time. The Transfer Pending page is displayed (Exhibit 248). 
Exhibit 248. Transfer Pending 

 
The equipment status remains Pending until the other mark accepts the transfer (described in 
Manage Access Rights Transferred to My Company on page 174). 

8. Select Done. 
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Manage Access Rights Transferred to My Company 
To accept or reject records or rights being transferred to the authorized user’s mark: 

1. Select Account Administration>Security Management, the Security Management page is 
displayed (Exhibit 195). 

2. Select the Manage Access Rights Transferred to My Company link. The Transfer Access 
Right page is displayed (Exhibit 249). 

Exhibit 249. Access Rights Transferred to My Company 

 

Exhibit 249 shows one pending transfer. 

3. Select the radio button for the pending transfer and select View. The Accept or Decline 
Transfer of Access Rights page is displayed (Exhibit 250). 

Exhibit 250. Accept or Decline Transfer of Access Rights 

 

a. To accept the transfer, select Accept. The Access Right Transfer page is displayed with 
the Status set to Accepted (Exhibit 251). 

b. To decline the transfer, select Decline. The Access Right Transfer page is displayed with 
the Status set to Declined (similar to Exhibit 251). 
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c. To exit without choosing, select Cancel to return to the Access Rights Transferred to My 
Company page (Exhibit 249). 

Exhibit 251. Access Right Transfer 

 

4. Select Done to return to the Access Rights Transferred to My Company page (Exhibit 249). 
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Configure Ticklers 
The Configure Ticklers function allows account administrators to specify which types of event 
notifications should be sent by Umler, and to which e-mail addresses. To configure ticklers: 

1. Select Account Administration>Configure Ticklers. The Configure Ticklers page is 
displayed (Exhibit 252). 

Exhibit 252. Configure Ticklers 

 

 
 

2. Select the check box beside the types of messages desired. 

3. For each message type selected, enter at least one e-mail address. Separate multiple e-mail 
addresses by a comma. Optionally, check the box not to send “no change” ticklers.  
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4. When all ticklers have been specified, select Save. A success message is displayed at the top 
of the page. 

5. To exit the page, select another Umler menu item. 
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Usage Statistics 
This function can be used by Company Administrators to monitor billable requests like web 
services and CSV downloads. To monitor usage statistics: 

1. Select Account Administration>Usage Statistics. The Usage Statistics page is displayed 
(Exhibit 253). 

Exhibit 253. Usage Statistics 

 

2. Select the users in the Select User field (multiple selection is allowed). 

3. Select the usage method, Web Services, CSV Downloads or leave blank to see both usage 
types. 

4. Select the starting and ending dates and times. 

Note: Only whole months can be processed. 3-month limit. 
 

5. Select Submit. The results are displayed online (Exhibit 254). 

Exhibit 254. Usage Statistics (results) 
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Contact List 
When the user selects Contact List, the Railinc FindUs.Rail application opens in a new window 
or tab (Exhibit 255). 

Exhibit 255. FindUs.Rail 

 

The Umler Contact List has been incorporated into Railinc’s FindUs.Rail application. Refer to 
FindUs.Rail for up-to-date Umler contact information. 

https://www.railinc.com/rportal/web/guest/findus 
 
Note: The appearance of the FindUs.Rail website is subject to change. It is beyond the scope of 

this document to discuss to use of FindUs.Rail. Once within the application, select the 
upper right Help link for online assistance. 

 

https://www.railinc.com/rportal/web/guest/findus
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Component Registry 
Using the Comprehensive Equipment Performance Monitoring (CEPM) function is described in 
the Umler™ Component Registry User Guide, which can be accessed from References. 
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Help 
Umler provides several forms of help from within the application. These include online help, and 
on some pages, field help. 

Online Help 
For each page that you navigate to within the Umler web application, select Help on the 
Application menu to access help related to that page. 

Exhibit 256. Help for Umler Page 
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Field Help 
As of  Umler 3.2, field help is available for selected pages, notably the Add or Modify Equipment 
pages, where specific information available in the Umler Data Specification Manual is needed to 
complete certain fields. 

To see help for a particular element, select its ID link. Umler opens a new browser window with 
help specific to that field. 

Exhibit 257. Field Help for Equipment Descriptor for Locomotive (field B341) 

 

The portion of the Umler Specification Manual for the car type element is displayed. If the 
material is larger than the default window size, scroll bars are provided. To enlarge the print, 
select the magnifying glass in the lower right. When finished viewing the data, close the window 
(select the upper right “X”, or press Alt+F4). 

Note: To print the help, press Ctrl+P while viewing and send to local printer. 
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References 
When the References menu item is selected, the Umler System Reference Materials page opens 
with a list of links to reference documentation (Exhibit 258). Documents and/or links include: 

• Umler® User Guide 
• Umler® Data Specifications Manual  
• Umler® Industry Reference and Load Files 
• Umler® Component Registry User Guide 
• Umler® Component Registry Data Specification Manual  

Exhibit 258. Umler System Reference Materials 

 

Note: The appearance of the Umler System Reference Materials page is subject to change.  
 

To view a reference document, select its link. The document opens in a new window. 

When finished viewing the document, close the window (select the Close button, select the upper 
right “X”, or press Alt+F4). Likewise, when finished with the documents reference page window, 
close it. 

To download a PDF of a reference document, right-click its link and select  “Save Target As….” 
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Index 
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code, 19 
equipment management, 88 
event response, 121 
mechanical designation, 19 
Rule 260, 19 

Collapse All button, 7 
description, 7 
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selecting, 9 

company-specific equipment group, 106 
add equipment, 114 
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delete, 110 
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search, 107 
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delete, 32 
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change rebuilt equipment, 19 
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transaction log, 44 
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conditional, 60 
mandatory, 59 
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in Query, 22 
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transaction logs, 45 
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special SSO requests, 165 
tickler, 176 
to user ID, 112 
Umler access notification, 9 
Umler administrator, 12 
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Add-Back, 64 
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delete, 80 
group, 19, 58 
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lookup single, 11 
maintenance party, 79 
modify multiple, 70 
modify single, 68 
Multiple Add-Back, 66 
restencil multiple, 75 
restencil single, 73 
restricted, 19 
single lookup, 11 

Equipment Group, 19 
change, 76 
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equipment management code, 88 
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SG, 88 
TC, 88 
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update, 88 
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Equipment Type, 19 
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error, 60 
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notice, 120 
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Expand All button, 7 

description, 7 
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expire 
access rights status, 158 

export, 28 
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Car Management Query, 34 
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delete, 130 

delete pool header, 85 
manage, 129 
pool assignment, 93 
pool unassignment, 94 
update pool header, 40 
view, 130 

Go button, 7 
description, 7 
usage, 70 

grant, 158 
access right, 158 
equipment right, 158 
inspection right, 158 
pool right, 158 
profile, 159 
view confidential data right, 158 

Grant Access Right button, 7 
description, 7 
usage, 157 

Grant Profiles button, 7 
description, 7 
usage, 159 

granted profile, 164 
accept, 164 
decline, 164 
management, 164 

granted right, 159 
accept, 161 
assign to profile, 163 
assign to user, 162 
decline, 161 
management, 160 
relinquish, 161 
revoke, 159 
view, 159 

grantee, 156 
add new, 157 
definition, 156 

grantor (definition), 156 
group ID, 108 
Group View, 108 
Held-Short Location, 34 

Create Pool Header, 84 
in Car Management query, 34 

help, 5 
field, 182 
online, 181 
overview, 181 
page, 5 

historical lineage, 52 
icon 

Display Unit, 5 
Umler-specific, 8 

information notice, 120 
inspection, 87 

add right, 146 
air brake, 97, 98 
air brake test device, 99 
autorack, 101 
car grade, 87, 102 
date done, 97, 98 
due date update, 104 
locomotive air brake, 103 
locomotive annual, 103 
locomotive cab signals, 103 
locomotive quarterly, 103 
locomotive RCL, 103 
overview, 95 
performer, 97, 98 
record, 95 
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reporter, 97, 98 
inspection history, 47 

details result, 51 
export CSV link, 50 
query, 47 
summary result, 50 

Launch Pad, 4 
legal, 5 
legal notices, 5 
lessee, 21 

definition, 21 
remove, 86 

letter of authorization, 165 
link, 4 

contact us, 5 
Create PDF, 15 
Launch Pad, 4 
navigational, 4 
next, 124 
previous, 124 
sign out, 5 

LOA, 165 
Loading Location, 34 

Car Management Query, 34 
Create Pool Header, 84 

location SPLC, 97, 99 
for Air Brake Test, 97, 99 
for Car Grade Inspection, 102 

locomotive inspection, 103 
locomotive storage event, 105 
log in, 9 
log off, 12 
logo (Railinc), 4 
Lookup tab, 15 
maintenance menu, 56 
manage future transaction, 129 
Maximum Number of Results field, 22 
MD, 88 
mechanical designation, 19 

Car Management Query, 35 
Company-Specific Equipment Groups, 108 
equipment query, 19 
transaction log, 44 

Mechanical Restriction, 90 
Mechanical Restriction Reason, 90 
menu, 5 

account administration, 137 
application, 5 
Help, 5 
maintenance, 56 
references, 5, 183 
Security Management, 139 

message area, 5 
metadata, 133 

reference file download, 133 
Microsoft Excel 

query output, 29 
modify, 68 

multiple equipment, 70 
single equipment, 68 

monitor usage, 178 
move equipment (company-specific equipment group), 118 
MR, 88 
MRR, 88 
My Saved Queries, 31 
navigational link, 4 
non-SSO user requests 

check status, 167 
create, 165 

notice, 119 

CSV export, 125 
CSV file column key, 125 
details, 124 
Error, 120 
group, 120 
Information, 120 
level, 120 
management overview, 119 
status, 120 
type, 120 
upload correction, 134 
Warning, 120 

Operator, 34 
Car Management query, 34 
Pool Header maintenance, 84 

page help, 5 
page title, 5 
PC, 88 
Pending status, 158 
pool, 139 

add right, 143 
range, 139 

pool assignment, 92 
from query, 93 
removal using query, 94 
to multiple pools, 93 
to one pool, 93 
update, 92 

pool control, 88 
pool header, 38 

create, 83 
delete, 85 
fields, 83 
update, 40 
view, 39 

Pool ID, 19 
Car Management Query, 34 
Create Pool Header, 83 
Equipment Query, 19 
transaction log, 44 

Pool Maintenance Code, 34 
Car Management Query, 34 
Create Pool Header, 84 

Pool Type, 35 
Car Management Query, 35 
Create Pool Header, 84 

Pool View (Car Management Query), 38 
privacy rights, 5 
quarterly inspection, 103 
query, 13 

action drop-down, 26 
browser or CSV, 22 
Car Management, 33 
count, 31 
Count, 25 
customize output, 22 
delete, 32 
display unit, 14 
download charge, 18 
equipment, 18 
export to CSV, 28 
historical lineage, 52 
inspection history, 47 
menu, 13 
Notices, 130 
Notices (Management), 123 
online results, 26 
processing options, 25 
reuse, 32 
save, 32 
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saved query table, 32 
Search, 25 
sort by fields, 23 

Railinc Customer Support Center, 3 
Railinc logo, 4 
RCL inspection, 103 
record transfer, 172 

accept, 174 
decline, 174 
receipt, 174 
release, 172 
view, 174 

reference documents, 183 
references, 5 
refresh, 135 

Umler 3.1, 136 
Umler 3.2, 135 

Relinquish button, 7 
description, 7 
usage, 161 

relinquish granted right, 161 
Relinquished status, 158 
remove, 86 

from pool, 94 
lessee, 86 

Reporter, 34 
Car Management Query, 34 
Create Pool Header, 83 

restencil, 73 
multiple equipment, 75 
single equipment, 73 
view confidential data right, 73 

Restore button, 7 
description, 7 
usage, 124 

resume suspended work, 127 
revoke, 159 

granted rights, 159 
granted security profile, 160 

Revoke button, 7 
description, 7 
usage, 159 

Revoked status, 158 
Rule 260 code, 19 
save query, 32 

function, 32 
Saved Queries, 31 

All Saved Queries, 31 
My Saved Queries, 31 
tab, 31 

SCAC, 137 
search, 13 

access right, 168 
Search Criteria tab, 26 
Security Management, 137 

Inter-company rights, 156 
Intra-company rights, 140 
menu (page), 139 
overview, 137 

security profile, 149 
add, 150 
add all to user, 155 
add for grantee, 160 
add grant, 161 
add/remove users, 154 
clone, 153 
definition, 149 
delete, 154 
delete access rights, 153 
edit, 152 

edit grantee, 160 
from other companies, 164 
grant, 159 
manage, 149 
name, 151 
remove all from user, 155 
revoke granted, 160 

select (in this document), 2 
SG, 88 
show database values, 6 

Comparison, 54 
Display, 15 
overview, 6 

Show Equipment button, 8 
description, 8 
usage, 39 

sign out link, 5 
Sign-On Information, 4 
single equipment lookup, 11 
Single Sign On (SSO), 9 
Spanish language option, 11 
Special Umler SSO Requests 

Approver approving, 167 
Approver rejecting, 167 
checking status, 167 
LOA, 165 
Requestor search, 167 
submitting for non-user, 165 

SPLC look up, 97, 99 
Standard Carrier Alpha Code, 137 
statistics (usage), 178 
Status, 158 

Accepted, 158 
Declined, 158 
Expired, 158 
Pending, 158 
Relinquished, 158 
Revoked, 158 

storage event (locomotive), 105 
support, 3 
suspended work, 127 

delete, 128 
resume, 127 

Switch View button, 8 
description, 8 
usage, 69 

system generated, 88 
tab 

Basic, 23 
Customize Query Output, 22 
Lookup, 15 
Saved Queries, 31 
Search Criteria, 26 

TC, 88 
TCC, 88 
terminology, 2 
terms of service, 5 
ticklers, 176 

configure, 176 
e-mail addresses, 176 
no change, 176 

timeframe of authority, 137 
title, 4 

application, 4 
page, 5 

transaction (bulk Umler upload), 133 
transaction log, 42 

search, 42 
viewing result, 46 

transfer, 172 
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receipt by company, 174 
release to company, 172 

Transfer button, 8 
description, 8 
usage, 173 

transportation code, 88 
transportation condition code, 88 
type of access, 138 
Umler, 1 

3.1 refresh, 136 
3.2 refresh, 135 
administrator, 12 
application menu, 6 
display record, 14 
icons, 8 
requesting changes, 2 
support, 3 
transaction upload, 133 
Version 3.8, 1 
Welcome page, 9 

Umler User Guide, 183 
Umler™ Component Registry, 180 

Data Specification Manual, 183 
User Guide, 183 

Umler™ Data Specifications Manual, 3 
description, 3 
in Reference Documents, 183 

Umler™ Industry Reference and Load Files, 183 
update, 40 

pool header, 40 
upload, 132 

notice corrections, 134 

Umler transactions, 133 
UR, 88 
usage statistics, 178 
Use Spanish for Error Messages and Properties, 6 
user, 9 

assign access rights, 141 
assign granted right, 161 
assign security profile, 154 
SSO, 9 

user contact info, 112 
user defined routing, 88 

definition, 88 
drop-down, 90 

User ID link, 112 
view, 39 

company-specific equipment group, 111 
components by location, 69 
conflicts, 11 
granted right, 161 
granted rights, 159 
pool header, 39 
record transfer, 174 
status of special SSO requests, 167 

view confidential data, 73 
for restencil, 73 
grant right, 158 

warning notice, 120 
web interface, 4 

page layout, 4 
Umler-specific elements, 6 

Welcome page, 9 
wildcard, 20 
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